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Overview 
This document provides instructions for installing the Deltek Time & Expense with Employee Self-
Service 9.0.1 (9.0.1.0) software. During this installation, you will perform the following steps: 

 Ensure that your system meets the installation prerequisites.  

 

Refer to the “Installation Prerequisites” and “System Requirements” sections for 
additional information. 

 Install and configure the Deltek Time & Expense with Employee Self-Service 9.0.1 
database. 

 Install the Oracle’s WebLogic® Server software. 

 Install and configure the Deltek Time & Expense with Employee Self-Service 9.0.1 
software. 

Installation Package Contents 
This package includes the following: 

 Deltek Time & Expense with Employee Self-Service 9.0.1 install. 

 Deltek Time & Expense with Employee Self-Service 9.0.1 Database install. 

 Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic install. 

 Deltek Time & Expense with Employee Self-Service 9.0.1 IIS install. 

 Deltek Time & Expense with Employee Self-Service 9.0.1 Mobile Time install. 

 Deltek Time & Expense with Employee Self-Service 9.0.1 Costpoint Interface install. 

 Deltek Time & Expense with Employee Self-Service 9.0.1 License file. 

 Deltek Time & Expense with Employee Self-Service Version 9.0.1 New Installation for 
Microsoft SQL Server document. 

Platforms Not Supported in Deltek Time & Expense with 
Employee Self-Service 9.0.1 
The Deltek Time & Expense with Employee Self-Service 9.0.1 system does not currently support 
Web servers other than Internet Information Server (for example, Apache). 

 

Deltek Time & Expense with Employee Self-Service may support other platforms in a future 
release.  

Discussion of Appendices 
This installation guide contains several important appendices that are listed in the following table: 

 

Appendix Title Description 
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Appendix Title Description 

A Documentation Instructions for accessing the Deltek Time & 
Expense with Employee Self-Service 9.0.1 
documents 

B Using Sample Data Domain Instructions for connecting to the Deltek Time 
& Expense with Employee Self-Service 9.0.1 
sample data domain 

C Using Microsoft’s Internet 
Information Server with Deltek 
Time & Expense with Employee 
Self-Service 9.0.1 

Instructions for integrating the Deltek Time & 
Expense with Employee Self-Service 9.0.1 
software with Microsoft’s Internet Information 
Server 

D Creating Additional Domains Instructions for creating additional Deltek Time 
& Expense with Employee Self-Service 9.0.1 
domains 

E Starting/Stopping Deltek Time & 
Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Instructions for starting and stopping the Deltek 
Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server 

F Installing Costpoint Interface 
Programs 

Instructions for installing the Deltek Time & 
Expense with Employee Self-Service 9.0.1 to 
Costpoint Interface programs, including the 
steps necessary to access Deltek Employee 
Self-Service 9.0.1 

G Implementing Secure Sockets 
Layer (SSL) Encryption with 
Deltek Time & Expense with 
Employee Self-Service 9.0.1 

Discussion of support for SSL encryption and 
the WebLogic licenses available for 
implementing SSL, references to information 
you can use to learn more about implementing 
SSL, and directions for changing the WebLogic 
license included with the standard distribution 
of Deltek Time & Expense with ESS 

H Lightweight Directory Access 
Protocol (LDAP) 

Instructions for setting up Lightweight Directory 
Access Protocol (LDAP), a protocol used to 
access "Directory Servers." The Directory is a 
special database that holds information in a 
tree structure. 

I Single Sign-On Instructions for implementing Single Sign-On 
with Windows Authentication. Also included is 
information on using this solution with Windows 
Network Load Balancing (NLB), ideas on 
troubleshooting problems, and some general 
considerations. 

J Changing WebLogic System 
User’s Password 

Instructions for changing the WebLogic system 
user’s password 
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Appendix Title Description 

K Migrating Time Collection 4.1 
Data to Deltek Time & Expense 
with Employee Self-Service 
9.0.1. 

Instructions for migrating your Time Collection 
4.1 data to your new Deltek Time & Expense 
with Employee Self-Service 9.0.1 database 

Naming Conventions 
This section discusses the naming conventions used throughout these installation instructions. 

Drive Letters 
The drive letter used in these installation instructions is listed in the following table. 

Drive Description 

C: This is the drive where the Deltek Time & Expense with Employee Self-Service 9.0.1 
system files are installed. 

Directory Names 
The directory names used in these installation instructions are listed in the following table. 

Directory Name Description 

ORACLE\MIDDLEWARE This is the name of the directory where the Oracle WebLogic and 
Deltek Time & Expense with Employee Self-Service 9.0.1 software 
is installed. 

DELTEKTE90 This is the name of the directory where the Deltek Time & Expense 
with Employee Self-Service 9.0.1 software is installed. 

TE90DB This is the name of the directory where the Deltek Time & Expense 
with Employee Self-Service 9.0.1 Database scripts are installed. 

Database Name 
The database name used in these installation instructions is listed in the following table. 

Database Name Description 

DELTEKTE This is the name of the Deltek Time & Expense with Employee Self-
Service 9.0.1 database. 

Internet Information 
Software installs, install instructions, technical guides, and release notes are available for 
download from the Deltek Software Manager (DSM). This is also where you will download 
software corrections and enhancements (hot fixes). DSM will be the only place to download the 
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hot fix files. Deltek Knowledge Base articles will still exist explaining the fixes, but will contain 
links to DSM for retrieving the actual files. 

Deltek Software Manager Requirements 
You must meet the following requirements in order to run DSM: 

 Can be run from any desktop (that is, does not have to be run on Deltek application 
servers) 

 Requires Windows XP or later 

 Requires Microsoft .NET Framework 3.5 SP1 (3.5.1) 

 The following Deltek Knowledge Base article has a link to download the framework 
and also has a few examples of what you may see if you do not have the framework 
installed: 

https://deltek.custhelp.com/app/answers/detail/a_id/52469  

 

Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

To Launch DSM 
Go to https://dsm.deltek.com. 

 

When downloading the Time & Expense with Employee Self-Service 9.0.1 software, if you are 
prompted to download Hot Fixes as well, please do so. 

Logon 
Use the same username/password as for Deltek Customer Care Connect. 

 

Deltek Knowledge Base articles will also exist on the Deltek Website (http://www.deltek.com). 

To view Knowledge Base articles: 

1. Go to http://www.deltek.com. 

2. Click Support Login in the upper right corner of the screen. 

3. When the Deltek Support Login screen displays, perform the following: 

 Username — Enter your Support user name. 

 Password — Enter your Support user’s password. 

4. Click Log In. 

 

If you have forgotten your username or password, click Account Assistance. If you 
have forgotten your username, enter your email address and click Email My 
Username. If you have forgotten your password, enter your username and click Reset 
My Password. 

5. When the Deltek Support Home Screen displays, click the Knowledge Center tab, and 
perform the following: 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/
http://www.deltek.com/
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 Refine by Product — Select Time & Expense from the drop-down list. 

 Refine by Category/Version — Expand Service Pack / Hot Fix from the drop-down 
list, and select 9.0.1. 

 Search Type — Leave as Phrases or select how you want to search from the drop-
down list. 

 Search by Keyword — Enter the specific text you are looking for, or leave blank to 
return all records for this version. 

6. Click Search. 

7. When the search results display, perform the following: 

 In the Summary column, click the link for the desired correction. 

 When the desired correction loads, click the links in the Answers section to 
download the files. 

System Requirements 
The Deltek Time & Expense with Employee Self-Service 9.0.1 system uses the following 
components: 

 Database Server 

 Application Server (with integrated Web Server) 

 Browser Client 

 IIS Web Server (optional) 

The hardware and software requirements for each of these components are listed in the following 
table: 

Component Hardware Requirements Software Requirements 

Database 
Server 

Hardware requirements vary among the 
different Relational Database 
Management System (RDBMS) 
platforms. Consult with Deltek’s 
Systems Solutions team or your 
RDBMS platform vendor to determine 
the hardware requirements for your 
database server. 

 Microsoft SQL Server 2012, 

Microsoft SQL Server 2008 
R2, 

Or 

Microsoft SQL Server 2008. 

Please note that Microsoft 
SQL Server 2005 is NO 
LONGER supported. 

 Database Compatibility 110 
(SQL Server 2012) 

Or 

Database Compatibility 100 
(SQL Server 2008 R2, SQL 
Server 2008). 
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Component Hardware Requirements Software Requirements 

Application 
Server 

 At least 900 MB of free disk space. 

 Pentium IV 2.0 GHz processor, or 
higher. Dual processors 
(recommended). 

 2 GB of RAM, or higher. 

 Raid 5 disk array (recommended). 

 Windows Server 2008 R2 

Or 

Windows Server 2008 64-bit. 

Please note that Windows 
Server 2008 32-bit and 
Windows Server 2003 are 
NO LONGER supported. 

 WebLogic 12.1.1 (provided 
with this installation 
package). 
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Component Hardware Requirements Software Requirements 

Browser Client 

Windows 

 Pentium IV 1.4 GHz processor, or 
higher. 

 512 MB of RAM, or higher. 

 Windows 7 (32-bit or 64-bit), 

Windows XP Professional 
SP2, 

Or 

Windows Vista SP2 (32-bit 
or 64-bit). 

 Internet Explorer Version 
9.0.1* (with latest service 
pack recommended), 

Or 

Internet Explorer Version 8.0 
(with latest service pack 
recommended). 

 Firefox 10*. 

 Chrome 11*. 

 Adobe Acrobat 8.1, or higher 
(required to display or print 
Deltek Time & Expense with 
Employee Self-Service 9.0.1 
reports). 

Please note that if you are 
planning on fax attaching 
items to expense 
reports/expense 
authorizations, the PDF 
created by Fax/copier must 
be version 1.4 or earlier. 

 Microsoft Excel 2007 SP1 
(required to use offline 
timesheets). 

* indicates the latest version 
tested at the time of 
release, newer versions 
should work. 
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Component Hardware Requirements Software Requirements 

Browser Client 

Mac 

 Must meet the hardware 
requirements support by the Mac 
OS X 10.5 or greater. 

 Mac OS X 10.5 or greater. 

 Safari 5.0*. 

 Firefox 10*. 

 Chrome 11*. 

 Adobe Acrobat 8.1, or higher 
(required to display or print 
Deltek Time & Expense with 
Employee Self-Service 9.0.1 
reports). 

Please note that if you are 
planning on fax attaching 
items to expense 
reports/expense 
authorizations, the PDF 
created by Fax/copier must 
be version 1.4 or earlier. 

* indicates the latest version 
tested at the time of 
release, newer versions 
should work. 

Browser Client 

Linux 

 Intel or AMD x86 (32/64 bit) 
processor, 1.4 GHz, or higher. 

 512 MB of RAM, or higher. 

 Linux Red Hat Enterprise OS 
5 Desktop. 

 Firefox 10*. 

 Chrome 11*. 

 Adobe Acrobat 8.1, or higher 
(required to display or print 
Deltek Time & Expense with 
Employee Self-Service 9.0.1 
reports). 

Please note that if you are 
planning on fax attaching 
items to expense 
reports/expense 
authorizations, the PDF 
created by Fax/copier must 
be version 1.4 or earlier. 

* indicates the latest version 
tested at the time of 
release, newer versions 
should work. 
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Component Hardware Requirements Software Requirements 

Web Server 
(optional) 

Hardware requirements vary among the 
different Web server platforms. Consult 
with Deltek’s Systems Solutions team or 
your Web server platform vendor to 
determine the hardware requirements 
for your Web server. 

 Microsoft Internet 
Information Server 7.0 (with 
latest service pack 
recommended). 

 

 

The Microsoft Internet Information Server component is optional. As part of this installation, you 
will install Oracle’s WebLogic Server application server software. The WebLogic Server software 
includes an integrated Web server component that you can use with the Deltek Time & Expense 
with Employee Self-Service 9.0.1 software. 
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Database Server Installation 
This section provides instructions and recommendations for creating your Deltek Time & Expense 
with Employee Self-Service 9.0.1 Microsoft SQL Server database. During this installation, you will 
create and populate the Deltek Time & Expense with Employee Self-Service 9.0.1 database 
schemas. These schemas are described in the following table. 

Schema Description 

TCLOGIN This schema is used for initial access to the system. 

TCIMPORT This schema is used to handle data integration between systems. 

TCDSI This schema is used to perform internal import operations within the Deltek Time 
& Expense with Employee Self-Service 9.0.1 system. 

TC_0000 This schema contains the system administration and system initialization data. 

TC_0001 This schema contains the Deltek Time & Expense with Employee Self-Service 
9.0.1 sample data. 

TC_0002 This is the first schema that contains your company’s Deltek Time & Expense with 
Employee Self-Service 9.0.1 data. 

Prerequisites 
Before beginning, the database server should meet the following prerequisites: 

 Hardware 

 Hardware requirements vary among the different Relational Database Management 
System (RDBMS) platforms. Please consult with Deltek’s Systems Solutions team or 
your RDBMS platform vendor to determine the hardware requirements for your 
database server. 

 Software 

 Microsoft SQL Server 2012, Microsoft SQL Server 2008 R2 or Microsoft SQL Server 
2008. 

 Database compatibility level 110 (SQL Server 2012) or 100 (SQL Server 2008 R2, 
SQL Server 2008). 

 

The installation requires you to know the Microsoft SQL Server sa user’s password. 

In order for the Deltek Time & Expense with Employee Self-Service 9.0.1 system to function 
properly, your WebLogic application server and the database server that hosts your Deltek Time 
& Expense with Employee Self-Service 9.0.1 database must have their system clocks 
synchronized with each other. Failure to do this may result in login and other system problems. 
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Step 1: Installing Deltek Time & Expense with Employee Self-
Service 9.0.1 Database Scripts and Programs 

Purpose 
This step provides instructions for installing the Deltek Time & Expense with Employee Self-
Service 9.0.1 database scripts. These scripts will be used to automate the creation of the Deltek 
Time & Expense with Employee Self-Service 9.0.1 database. 

Where 
This step must be performed on the Microsoft SQL Server database server that will host your 
Deltek Time & Expense with Employee Self-Service 9.0.1 database or a Windows client 
workstation that has osql connectivity to the Microsoft SQL Server database server that will host 
your Deltek Time & Expense with Employee Self-Service 9.0.1 database. 

 

This install will automatically create your Deltek Time & Expense with Employee Self-Service 
9.0.1 Microsoft SQL Server database. However, after the database installation is complete, you 
should use Microsoft SQL Server Enterprise Manager to verify the new Deltek Time & Expense 
with Employee Self-Service 9.0.1 database’s configuration parameters and set up any 
necessary maintenance procedures. 

To install the Deltek Time & Expense with Employee Self-Service 9.0.1 database scripts, 
complete the following steps: 

1. Run DeltekTimeAndExpense901Database.exe to launch the Deltek Time & Expense 
with Employee Self-Service 9.0.1 Database installation program. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and then click Next. 

 

It can take several minutes for the License Agreement screen to display. 

4. When the Select Database Platform screen displays, select the Microsoft SQL Server 
option, and click Next. 

5. When the Choose Version of SQL Server screen displays, perform the following: 

 SQL Server 2008 — Select this option if you are running Microsoft SQL Server 2008. 

 SQL Server 2008 R2 — Select this option if you are running Microsoft SQL Server 
2008 R2. 

 SQL Server 2012 — Select this option if you are running Microsoft SQL Server 2012. 

Click Next. 
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6. When the Choose Install Folder screen displays, indicate where you want to install the 
database scripts. Either accept the default folder (C:\TE90DB) or click Choose to select 
a different folder. After you have chosen the folder, click Next. 

 

The path and folder name you choose CANNOT contain any spaces. 

7. When the Enter Microsoft SQL Server Database Information screen displays, perform the 
following: 

 Server Name — Enter the computer name (for example, dbsvr01) or IP address (for 
example, 10.2.2.154) used to identify your SQL Server database server. The name of 
the computer running this install will default. 

 Database Name — Enter the name you want to use for your SQL Server database. 
The default database name is DELTEKTE (recommended). Scripts generated by this 
installation will use this name to create your new Deltek Time & Expense with 
Employee Self-Service 9.0.1 database. 

 sa Password — Enter the password for the Microsoft SQL Server sa user. 

 Confirm sa Password — Re-enter the password. 

Click Next. 

 

The program will compare the Microsoft SQL Server sa account password entries to 
ascertain that you have correctly typed the password values. 

8. When the Enter Microsoft SQL Server Data File Location screen displays, indicate the 
location of your Microsoft SQL Server database server’s data files. Either accept the 
default folder (SQL Server 2008 default - C:\Program Files\Microsoft SQL 
Server\MMSSQL10.MSSQLSERVER\MSSQL\DATA, SQL Server 2008 R2 default - 
C:\Program Files\Microsoft SQL 
Server\MMSSQL10_50.MSSQLSERVER\MSSQL\DATA, SQL Server 2012 default - 
C:\Program Files\Microsoft SQL 
Server\MMSSQL11.MSSQLSERVER\MSSQL\DATA), or click Choose to select a 
different folder.  

The Microsoft SQL Server data files associated with your Deltek Time & Expense with 
Employee Self-Service 9.0.1 database will be stored in the folder you choose. When you 
have chosen the folder, click the Next button. 

 

If you have chosen a folder that does not currently exist, the installation will prompt you 
to create the new folder. 

9. When the Enter Microsoft SQL Server Database Passwords screen displays, enter the 
passwords for the accounts/schemas listed on the screen. These schemas will be 
populated with data and used for establishing connection pools to your Deltek Time & 
Expense with Employee Self-Service 9.0.1 database. Please provide passwords for all of 
the following accounts/schemas, and then click Next: 

 TC_0000 

 TC_0001 

 TCDSI 

 TCLOGIN 
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 TCIMPORT 

 

Make sure these passwords conform to your SQL Server password policies. 

It is critical that you remember these passwords. Please make a note of them. You will 
need to enter them in other parts of the installation. 

10. When the Confirm Microsoft SQL Server Database Passwords screen displays, re-enter 
the passwords for the accounts/schemas, and then click Next. 

11. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

12. When the Install Complete screen displays, click Done to exit the installation. 

13. Review the log file 
C:\TE90DB\Time_&_Expense_with_Employee_Self_Service_9.0.1_Database_Install
Log.log. Scroll down to the Summary section, and report any Warnings, NonFatalErrors, 
or FatalErrors to Deltek Technical Support. 

 

Please make sure that your SQL Server port, 1433 (the default), is opened for 
Inbound and Outbound traffic through your firewall. 

Please make sure Network discovery and file sharing are turned on. 

Step 2: Creating Deltek Time & Expense with Employee Self-
Service 9.0.1 Database 

Purpose 
This step provides instructions for using the database scripts created in the previous step to 
automatically create and populate the Deltek Time & Expense with Employee Self-Service 9.0.1 
database schemas. 

Where 
This step must be performed on the same computer where you installed the Deltek Time & 
Expense with Employee Self-Service 9.0.1 database scripts. 

To create and populate the Deltek Time & Expense with Employee Self-Service 9.0.1 
database, complete the following steps: 

1. Open a Windows Command Prompt, navigate to the directory where the Deltek Time & 
Expense with Employee Self-Service 9.0.1 database scripts were installed (C:\TE90DB), 
and launch the following command script: 

teDBmss 

2. After the teDBmss command script completes, open the teDBmss.log file (in the 
C:\TE90DB directory) with a text editor, and search for any msg messages. If any msg 
messages are found contact Deltek Technical Support. 

3. Close the Windows Command Prompt. 

This procedure created the Deltek Time & Expense with Employee Self-Service 9.0.1 database. 
Use Microsoft’s SQL Server Enterprise Manager to verify your new database’s configuration 
parameters, and set up any necessary maintenance procedures. 
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The following files in your Deltek Time & Expense with Employee Self-Service 9.0.1 database 
installation directory (C:\TE90DB) contain the database user passwords you provided earlier 
during the installation: 

 teDBmss.sql 

 teDBmss.cmd 

Store these files in a secure location or remove them after you have successfully completed the 
installation. 
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WebLogic Application Server Installation 
The Deltek Time & Expense with Employee Self-Service 9.0.1 system uses Oracle’s WebLogic 
Server for its application server tier. This section discusses how you will install the WebLogic 
Server 12.1.1 application server software and the Deltek Time & Expense with Employee Self-
Service 9.0.1 software. 

 

The Time & Expense with Employee Self-Service 9.0.1 WebLogic application server should not 
contain any previous versions of WebLogic or Time & Expense with Employee Self-Service. 

Prerequisites 
The application server that will host the WebLogic Server and Deltek Time & Expense with 
Employee Self-Service 9.0.1 software must meet the following prerequisites: 

 Hardware 

 At least 900 MB of free disk space. 

 Pentium IV 2.0 GHz processor, or higher; dual processors (recommended). 

 2 GB of RAM, or higher. 

 Raid 5 disk array (recommended). 

 Software 

 Windows Server 2008 R2 or Windows Server 2008 64-bit. 

 Other Servers 

 On your Database Server, SQL Server Listen Port 1433 must be open for Inbound 
and Outbound traffic through your firewall. 

 On your Database Server, please make sure Network discovery and file sharing 
are turned on. 

Step 1: Installing WebLogic Server 

Purpose 
This step provides instructions for installing Oracle’s WebLogic Server 12.1.1 application server 
software. 

Where 
This step must be performed on the machine that will serve as your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

To install the WebLogic Server 12.1.1 software, complete the following steps: 

1. Run DeltekTimeAndExpense901WebLogic.exe to launch the WebLogic Server 
installation program. 
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Due to enhanced security in Windows Server 2008 it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and click Next. 

4. When the Choose WebLogic Home Directory screen displays, perform the following: 

 Please choose WebLogic Home directory — Enter a folder name. The default is 
C:\Oracle\Middleware (recommended). 

 

Do not install the WebLogic Server software in a directory path or folder that contains a 
space. The Deltek Time & Expense with Employee Self-Service 9.0.1 software will not 
function properly if the WebLogic Server software is installed to a directory path or 
folder that contains a space.  

Take note of the WebLogic install directory. You will be prompted to enter this directory 
when performing the Deltek Time & Expense with Employee Self-Service 9.0.1 
software installation. 

5. Click Next. 

6. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

 

This install will take several minutes to complete. Do not interrupt it. You will notice a 
Windows Command Prompt. Please do not close this screen—when the installation 
has completed this screen will close. 

7. When the Install Complete screen displays, click the Done button to exit the installation. 

8. Review the log file, 
C:\Oracle\Middleware\logs\Time_&_Expense_with_ESS_9.0.1_Oracle_WebLogic_1
2.1_InstallLog.log. Scroll down to the Summary section, and report any Warnings, 
NonFatalErrors, or FatalErrors to Deltek Technical Support. 

Step 2: Installing Deltek Time & Expense with Employee Self-
Service 9.0.1 Software 

Purpose 
During this step, you will install the Deltek Time & Expense with Employee Self-Service 9.0.1 
software. 

Where 
This step must be performed on the WebLogic application server that will host your Deltek Time & 
Expense with Employee Self-Service 9.0.1 software. 

To install the Deltek Time & Expense with Employee Self-Service 9.0.1 software, complete 
the following steps: 
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1. Run DeltekTimeAndExpense901.exe to launch the Deltek Time & Expense with 
Employee Self-Service 9.0.1 installation program. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer, and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and then click Next. 

 

It can take several minutes for the License Agreement screen to display. 

4. When the Enter your WebLogic Home Directory screen displays, select the WebLogic 
Install folder you specified during the WebLogic Server installation. If the default 
(C:\Oracle\Middleware) is not the correct location, click Choose to select the correct 
folder. When you have chosen your WebLogic Home folder, click Next. 

 

The WebLogic Server software cannot reside in a directory path or folder that contains 
a space. If you have installed to a directory path or folder that contains a space, you 
must remove the WebLogic Server software and reinstall it to a directory path and 
folder that does not contain a space. 

After you click Next to continue, the program will attempt to locate the registry.dat file 
located in the folder specified. The installation searches for the registry.dat file to verify 
that you have correctly specified the WebLogic Install folder. The installation will not 
allow you to proceed if this file is not found. 

5. When the Enter WebLogic Server Information screen displays, perform the following: 

 IP Address or Hostname — Accept the default hostname (for example, appsvr01) 
or enter the IP address (for example, 10.2.2.154) of your WebLogic application 
server. 

 

The IP Address or Hostname cannot be 127.0.0.1 or localhost. 

 Listen Port — Enter the port that you want your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic Server to use to listen for connections. The 
default is 7009 (recommended). 

 

Deltek recommends using 7009 as the listen port unless it conflicts with other 
applications installed on this server. 

6. Click Next. 

7. When the Select Database Platform screen displays, select the Microsoft SQL Server 
option, and click Next. 

8. When the Enter Microsoft SQL Server Database Information screen displays, perform the 
following: 
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 IP Address or Hostname — Enter the IP address (for example, 10.2.2.154) or 
hostname (for example, dbsvr01) of your Deltek Time & Expense with Employee 
Self-Service 9.0.1 database server. The Deltek Time & Expense with Employee Self-
Service 9.0.1 software uses this information to communicate with your Deltek Time & 
Expense with Employee Self-Service 9.0.1 database server. 

 

The IP Address or Hostname cannot be 127.0.0.1 or localhost. 

 Port — Enter the port that your database server software uses to listen for requests. 
The default port for Microsoft SQL Server is 1433. 

 Database Name — Enter the Deltek Time & Expense with Employee Self-Service 
9.0.1 Database Name you entered during the Database Installation “Step 1: Installing 
Deltek Time & Expense with Employee Self-Service 9.0.1 Database Scripts and 
Programs” item 7. The default is DELTEKTE. 

9. Click Next. 

10. When the Enter Microsoft SQL Server Database Passwords screen displays, enter the 
passwords for the following accounts/schemas and then click Next: 

 

You created these schemas and assigned passwords to them during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 Database installation. You must enter the 
actual passwords that are currently assigned to these database accounts/schemas. 
This installation will not assign new passwords to these schemas. 

 TC_0001 

 TCDSI 

 TCLOGIN 

11. When the Confirm Microsoft SQL Server Database Passwords screen displays, re-enter 
the passwords for the preceding accounts/schemas and click the Next button. 

12. When the Choose Shortcut Folder screen displays, select the menu location for the Start 
Time & Expense with ESS 9.0.1 Server product icon. The default is Deltek Time & 
Expense with ESS 9.0.1 (recommended). If you want the product icon installed for all 
users, select the Create Icons for All Users check box. 

13. Click Next. 

14. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

15. When the process is complete, the Install Complete screen displays. Perform the 
following: 

 Select the Yes, restart my system option. 

 Click Done to exit the installation and reboot your Deltek Time & Expense 9.0.1 
WebLogic application server. 

16. Review the log file, 
C:\Oracle\Middleware\DeltekTE90\Time_&_Expense_with_Employee_Self_Service_
9.0.1_InstallLog.log. Scroll down to the Summary section, and report any Warnings, 
NonFatalErrors, or FatalErrors to Deltek Technical Support. 
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Please make sure that your WebLogic Listen port, 7009 (the default), is opened 
for Inbound and Outbound traffic through your firewall. 

Please make sure Network discovery and file sharing are turned on. 
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Deltek Time & Expense with Employee Self-
Service 9.0.1 System Configuration 
In this section, you will complete the following steps to configure your Deltek Time & Expense 
with Employee Self-Service 9.0.1 software: 

 Preserve your Deltek Time & Expense with Employee Self-Service 9.0.1 license file 

 Start your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic 
application server 

 Use the browser-based WebLogic console utility to create your Deltek Time & Expense 
with Employee Self-Service 9.0.1 company domain 

Prerequisites 
The browser client workstation that will access the WebLogic console utility must meet the 
following prerequisites: 

 Hardware 

 Pentium IV 1.4 GHz processor, or higher. 

 512 MB of RAM, or higher. 

 Software 

 Internet Explorer Version 9.0.1 (with latest service pack recommended), Internet 
Explorer Version 8.0 (with latest service pack recommended), Firefox 10, or Chrome 
11. 

 Windows 7, Windows Vista SP2, Windows XP Professional (with Service Pack 2), or 
Windows Server 2008. 

 Servers 

 On your Database Server, SQL Server Listen Port 1433 must be open for Inbound 
and Outbound traffic through your firewall. 

 On your Database Server, make sure Network discovery and file sharing are 
turned on. 

 On your Application Server, WebLogic Listen Port 7009 must be open for Inbound 
and Outbound traffic through your firewall. 

 On your Application Server, make sure Network discovery and file sharing are 
turned on. 

Step 1: Preserving Deltek Time & Expense with Employee Self-
Service 9.0.1 License File 

Purpose 
This step provides instructions for preserving your Deltek Time & Expense with Employee Self-
Service 9.0.1 license file. 
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Deltek recommends that you copy your Deltek Time & Expense with Employee Self-Service 
9.0.1 license file, DELTEKTE.LIC, to a secure location. You will need this file to be contained in 
the C:\Oracle\Middleware\DeltekTE90\scripts directory each time you create a new Deltek 
Time & Expense with Employee Self-Service 9.0.1 company domain. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To preserve your Deltek Time & Expense with Employee Self-Service 9.0.1 license file, 
complete the following step: 

1. Copy the DELTEKTE.LIC license file you received to the 
C:\Oracle\Middleware\DeltekTE90\scripts directory. 

Step 2: Starting Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for starting your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. You must start the WebLogic Server on your application server 
to gain access to the Deltek Time & Expense with Employee Self-Service 9.0.1 system. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To start your WebLogic server, complete the following steps: 

1. In order for the Start Time & Expense with ESS 9.0.1 Server Windows Command Prompt 
to have scrolling capability, perform the following: 

a. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1. 

b. Right-click Start Time & Expense with ESS 9.0.1 Server, and click Properties on 
the shortcut menu. 

c. When the Start Time & Expense with ESS 9.0.1 Server Properties screen displays, 
click the Layout tab and increase the Screen buffer size Height from 300 to 3000. 

d. Click OK to save the changes. 

 

Before starting Time & Expense with ESS 9.0.1, make sure that all of your ports are 
opened for Inbound and Outbound traffic through your firewall: 

Database Server Port 

 Listen — 1433 (the default) 

Application Server Port 

 Listen — 7009 (the default)  

2. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. This will open a Windows Command Prompt and 
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launch a command script that starts the WebLogic Server. When the Windows Command 
Prompt window opens, you will see a series of messages scrolling down the screen. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

It will take several minutes for the WebLogic Server to start. 

3. If your WebLogic Server starts successfully, the following message displays near the 
bottom of the command line shell window: 

<The server started in RUNNING mode.> 

 

If your WebLogic Server encounters errors during the startup process, the <The server started 
in RUNNING mode.> message will not display and the command line shell (DOS window) may 
terminate. If you do not receive the <The server started in RUNNING mode.> message or the 
command line shell terminates, you must do the following tasks: 

 Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file. 

 Contact Deltek Technical Support. 

Step 3: Creating Deltek Time & Expense with Employee Self-
Service 9.0.1 Company Domain 

Purpose 
This step provides instructions for creating your Deltek Time & Expense with Employee Self-
Service 9.0.1 company domain. 

Where 
This step must be performed from a workstation that has Web browser client access via TCP/IP 
to the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this workstation. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available for download at http://java.com. 

To create your Deltek Time & Expense with Employee Self-Service 9.0.1 company domain, 
complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server; and 

http://java.com/
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 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009 
(for example, http://10.2.2.154:7009/console). 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

3. Click Login. 

4. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (for example, http://10.2.2.154) to your Internet 
Browser Trusted Sites and/or install Sun Microsystems’ latest JVM.  

5. When the Settings for DeltekTE screen displays, click the Application Configuration 
tab, and then click the Create New Domain link. 

6. When the Database Login screen displays, perform the following: 

 Database Login ID — Accept the default of sa. 

 Database Password — Enter the Microsoft SQL Server sa user’s password. 

7. Click Ok. 

8. When the Deltek Application Configuration Home screen displays, perform the following: 

 Target Version — Accept the default of 9.0.1.0. 

 Schema — Accept the default of the next available database schema (for example, 
TC_0002). 

 Domain Name — Enter the name you want to use when logging into your Deltek 
Time & Expense with Employee Self-Service 9.0.1 system. The Domain is an alias 
for the TC_0002 database schema and will, typically, be shorthand for your company, 
division or department name. The Domain name you choose cannot be greater than 
30 characters and cannot contain spaces.  

 

This domain name will be referred to as <Your_Domain_Name> throughout the 
remainder of these instructions. 

 Domain Password — Enter a password for the TC_0002 database schema. 

 Domain Password (Verify) — Re-enter the password. 

 License File — Click Browse, navigate to your 
C:\Oracle\Middleware\DeltekTE90\scripts directory, select the DELTEKTE.LIC 
file, and click Open. If you are not on the WebLogic application server, enter the 
actual location of your license file on the application server (for example, 
C:\Oracle\Middleware\DeltekTE90\scripts\DELTEKTE.LIC). 
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 Default Database — Enter the Deltek Time & Expense with Employee Self-Service 
9.0.1 Database Name you entered during the Database Installation “Step 1: Installing 
Deltek Time & Expense with Employee Self-Service 9.0.1 Database Scripts and 
Programs” item 7. The default is DELTEKTE. 

9. Click Execute to begin the upgrade process. 

 

It can take several minutes to perform the upgrade. Upon successful completion, you 
will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please complete the 
following steps: 

 Execute the following SQL statement in SQL Query Analyzer, connected to 
your DELTEKTE database as the sa user: 

SELECT * FROM TC_0000.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

10. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. 

11. When the Deltek Application Configuration Home screen displays, in the fields that 
display below the Domain Name heading, click the <Your_Domain_Name> link. 

12. When the Domain <Your_Domain_Name> screen displays, enter the following: 

 Domain Name — Accept the default of <Your_Domain_Name>. 

 Schema Name — Accept the default of TC_0002. 

 Status — Accept the default selection of the Enabled option. 

 Locale — Accept the default of English (United States) or change to your preferred 
locale. 

 Company Logo — Enter the directory path location and name of the company logo 
graphics file that will display in the heading of your Deltek Time & Expense with 
Employee Self-Service 9.0.1 reports by performing one of the following: 

 Accept the default directory path location and name of the Deltek supplied 
company logo graphics file: 

/DeltekTC/com/deltek/tc/framework/images/companyLogo.gif 

 Specify your company’s logo graphics file by performing the following: 

a. Copy your company’s logo graphics file to the 
DELTEKTE90\applications\TC\DeltekTC\com\deltek\tc\framework\images 
directory located beneath your WebLogic home folder (that is, 
C:\Oracle\Middleware) on your WebLogic application server. 

b. Enter the following value in the Company Logo field: 

/DeltekTC/com/deltek/tc/framework/images/<Your_Company_Logo.gif> 

Where: 

<Your_Company_Logo.gif> identifies the name of your company’s logo 
graphics file (that is, MyCompanyLogo.gif). 
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For example, if your company’s logo graphics file is named 
MyCompanyLogo.gif, you would copy this file to the 
C:\Oracle\Middleware\DeltekTE90\applications\TC\DeltekTC\com\deltek\t
c\framework\images directory on your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server and enter the 
following value in the Company Logo field: 

/DeltekTC/com/deltek/tc/framework/images/MyCompanyLogo.gif 

 The Deltek Time & Expense with Employee Self-Service 9.0.1 
reports will not function properly unless you supply a valid value 
for this field. If you do not have your own company logo 
graphics file, you must specify the Deltek supplied sample file 
by entering 
/DeltekTC/com/deltek/tc/framework/images/companyLogo.g
if. 

 The dimensions for the company logo graphics file are as 
follows: 

 Resizable in width — up to 100 pixels. 

 Resizable in height — up to 50 pixels. 

 Branding Area Graphic — Enter the directory path location and name of the 
branding area graphics file that will display at the top of your Deltek Time & Expense 
with Employee Self-Service 9.0.1 system's Web pages by performing one of the 
following: 

 Accept the default directory path location and name of the Deltek supplied 
branding area graphics file: 

/DeltekTC/com/deltek/tc/framework/images/TC_branding_Area.jpg 

 Specify your company’s branding area graphics file by performing the following: 

a. Copy your company’s branding area graphics file to the 
DELTEKTE90\applications\TC\DeltekTC\com\deltek\tc\framework\images 
directory located beneath your WebLogic home folder (that is, 
C:\Oracle\Middleware) on your WebLogic application server. 

b. Enter the following value in the Branding Area Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/<Your_Branding_Area.jpg> 

Where: 

 <Your_Branding_Area.jpg> identifies the name of your company’s 
branding area graphics file (that is, MyCompanyBranding.jpg). 
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For example, if your company’s branding area graphics file is named 
MyCompanyBranding.jpg, you would copy this file to the 
C:\Oracle\Middleware\DeltekTE90\applications\TC\DeltekTC\com\deltek\t
c\framework\images directory on your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server and enter the 
following value in the Branding Area Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/MyCompanyBranding.gif 

 The dimensions for the branding area graphics file are as 
follows: 

 Resizable in width — up to 780 pixels. 

 Fixed in height — 50/25 pixels (50 pixels above the 
navigation area and 25 pixels above the application name 
area on the Deltek Time & Expense with Employee Self-
Service 9.0.1 system's Web pages). 

 For additional information on the branding area graphics file, 
see the 
DeltekTimeAndExpense83TechnicalGuideTimeAndExpensewit
hESS.pdf file. 

 Splash Screen Graphic — Enter the directory path location and name of the splash 
screen graphics file that will display when users login to your Deltek Time & Expense 
with Employee Self-Service 9.0.1 system by performing one of the following: 

 Accept the default directory path location and name of the Deltek supplied splash 
screen graphics file: 

/DeltekTC/com/deltek/tc/framework/images/splashScreen.gif 

 Specify your company’s splash screen graphics file by performing the following: 

a. Copy your company’s splash screen graphics file to the 
DELTEKTE90\applications\TC\DeltekTC\com\deltek\tc\framework\images 
directory located beneath your WebLogic home folder (that is, 
C:\Oracle\Middleware) on your WebLogic application server. 

b. Enter the following value in the Splash Screen Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/<Your_Splash_Screen.gif> 

Where: 

 <Your_Splash_Screen.gif> identifies the name of your company’s splash 
screen graphics file (that is, MyCompanySplash.gif). 
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For example, if your company’s splash screen graphics file is named 
MyCompanySplash.gif, you would copy this file to the 
C:\Oracle\Middleware\DeltekTE90\applications\TC\DeltekTC\com\deltek\t
c\framework\images directory on your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server and enter the 
following value in the Splash Screen Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/MyCompanySplash.gif 

 The dimensions for the splash screen graphics file are as 
follows: 

 Resizable in width — up to 680 pixels. 

 Resizable in height — up to 335 pixels. 

 For additional information on the splash screen graphics file, 
please see the 
DeltekTimeAndExpense83TechnicalGuideTimeAndExpensewit
hESS.pdf file. 

 Authentication Method — Select the authentication method you want to use: 
Database, LDAP, or SSO. The default is Database. 

 

Select LDAP if your WebLogic server will be working with a Microsoft Active 
Directory Lightweight Directory Access Protocol (LDAP) server. 

 Login ID Source — Select the type of login you want to use: LOGIN_ID or 
CONTEXT_ID. The default is LOGIN_ID. 

 Case Sensitive Login ID — Select this check box to make your login case-sensitive. 
The default is selected. To log in to all new domains that you create as the install 
user, you must select this check box. 

 Mixed Case Password — Accept the default. 

 Attachment Storage Method — Select the method of storage for expense 
attachments: File System (default) or Database. 

 Export Location — Accept the default. 

 Import Location — Accept the default. 

 Trash Location — Accept the default. 

 Traveler Import Location — Accept the default. 

 Traveler Rejection Location — Accept the default. 

 Traveler Examination Level — Accept the default of 1 - fastest. 

 Save Login Id to Cookie — Accept the default. 

 Save Domain to Cookie — Accept the default. 

 Receipt Storage Location — Accept the default. 

 Mobile Message Bundle Location — Accept the default. 

 Employee Password Self Reset — Accept the default. 

 English (United States) — Accept the default. 

 System Email Address — Accept the default. 

 Time Sender Email Address — Accept the default. 
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 Expense Sender Email Address — Accept the default. 

 ESS Sender Email Address — Accept the default. 

 SMTP Server Name — Accept the default. 

 SMTP Port — Accept the default. 

 SMTP User ID — Accept the default. 

 SMTP Password — Accept the default. 

 Timesheet Pre Save — Accept the default. 

 Timesheet Post Save — Accept the default. 

 Timesheet Pre Sign — Accept the default. 

 Timesheet Post Sign — Accept the default. 

 Timesheet Pre Approve — Accept the default. 

 Timesheet Post Approve — Accept the default. 

 ER Pre Sign — Accept the default. 

 ER Post Sign — Accept the default. 

 ER Pre Save — Accept the default. 

 ER Post Save — Accept the default. 

 EA Pre Save — Accept the default. 

 EA Post Save — Accept the default. 

 EA Pre Sign — Accept the default. 

 EA Post Sign — Accept the default. 

13. Click Save Changes. 

14. When the “Process Completed Successfully!” message displays, click the Deltek 
Application Configuration Home link that displays near the bottom of the screen. 

 

If you receive any error codes instead of the above message, please contact Deltek 
Technical Support. 

15. Click the DeltekTE link that displays under the Domain Structure section in the middle 
of the left pane. 

16. When the Settings for DeltekTE screen displays, click the Control tab, and perform the 
following: 

 DeltekTEServer (admin) — Select the check box that displays to the left. 

 Click Shutdown, and select Force Shutdown Now. 

17. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

18. Close the Web browser screen. 
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Deltek recommends that you establish a Database Maintenance Plan for your Microsoft SQL 
Server Deltek Time & Expense with Employee Self-Service 9.0.1 database. Your Database 
Maintenance Plan must include a regularly scheduled task that updates the database statistics 
used by the SQL Server query optimizer. Regular updating of the statistics will ensure that the 
query optimizer has up-to-date information about the distribution of data values in the Deltek 
Time & Expense with Employee Self-Service 9.0.1 database's tables. Consult your Microsoft 
SQL Server documentation for additional information on creating a Database Maintenance Plan 
for your Deltek Time & Expense with Employee Self-Service 9.0.1 database. 

Step 4: Installing Help Files for Deltek Time & Expense 9.0.1 
Company Domains 

Purpose 
This step provides instructions for installing the help files for your Deltek Time & Expense 9.0.1 
company domains. 

Where 
This step must be performed on your Deltek Time & Expense 9.0.1 WebLogic application server. 

To install the help files for your Deltek Time & Expense 9.0.1 company domains, complete 
the following steps: 

1. Open a Windows Command Prompt and launch the following command script: 

TEHelpFiles <Your_Domain_Name> 

Where: 

 <Your_Domain_Name> identifies the domain name you will use when logging into 
your Time & Expense company domain. The Domain name cannot contain spaces. 

For example, If your company domain name is ACME, you would enter the following: 

TEHelpFiles ACME 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

When you launch the TEHelpFiles <Your_Domain_Name> script, the Windows 
Command Prompt will display the message “Copying files….” If you are prompted with 
an “Overwrite C:\Oracle\Middleware\DeltekTE90\... <Yes/No/All>” message, you must 
enter Y to overwrite your file with the latest one. A “Copy complete…” message 
displays when the copy process is finished. 

2. Launch this command script, as described above, for each of your other company 
domains. 

3. Close the Windows Command Prompt. 
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Step 5: Installing and Starting Deltek Time & Expense with ESS 
9.0.1 Service 

Purpose 
This step provides instructions for setting up and starting the Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server instance to run as a Windows service. 

Where 
This step must be performed on your Deltek Time & Expense 9.0.1 WebLogic application 
server. 

To install and start the Deltek Time & Expense with Employee Self-Service 9.0.1 to run as a 
Windows service, complete the following steps: 

1. Open a Windows Command Prompt and launch the following command script: 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

InstallTEService 

2. When the “Time & Expense with ESS 9.0.1 installed” message displays, close the 
Windows Command Prompt. 

3. Click Start » Programs » Administrative Tools » Services. 

4. When the Services window displays, scroll down the Services list, right-click the Time & 
Expense with ESS 9.0.1 service, and click Properties on the shortcut menu. 

5. When the Time & Expense with ESS 9.0.1 Properties screen displays, click the 
Recovery tab, and perform the following: 

 First failure — Change the drop-down selection from Take No Action to Restart 
the Service. 

 Second failure — Accept the default of Take No Action. 

 Subsequent failures — Accept the default of Take No Action. 

 Reset fail count after — Change from 0 to 1 days. 

 Restart service after — Accept the default of 1 minutes. 

6. Click Apply. 

7. In the Time & Expense with ESS 9.0.1 Properties screen, click the General tab, and click 
the Start button to start the Time & Expense with ESS 9.0.1 service. 

 

The service will indicate that it started immediately. Please note, however, that it will 
take several minutes for the Time & Expense with ESS 9.0.1 service to fully initialize. 

After starting the service, you must wait several minutes before attempting to connect 
to the software. 

If you encounter problems with the Time & Expense with ESS 9.0.1 service, check the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log file 
and report any errors to Deltek Technical Support. 

8. Click OK to close the Time & Expense with ESS 9.0.1 Properties screen. 
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9. Close the Services window. 
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Logging into Deltek Time & Expense with 
Employee Self-Service 9.0.1 
This section provides instructions for verifying your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server installation. To confirm that your system is functioning properly, 
you will log in to your Deltek Time & Expense with Employee Self-Service 9.0.1 company domain. 

Prerequisites 
This step requires that your client meets the following hardware and software prerequisites: 

 Hardware 

 Pentium IV 1.4 GHz processor, or higher. 

 512 MB of RAM, or higher. 

 Software 

 Internet Explorer Version 9.0.1 (with latest service pack recommended), Internet 
Explorer Version 8.0 (with latest service pack recommended), Firefox 10, or Chrome 
11. 

 Adobe Acrobat 8.1, or higher (required to display or print Deltek Time & Expense with 
Employee Self-Service 9.0.1 reports).  Please note that if you are planning on fax 
attaching items to expense reports/expense authorizations, the PDF created by 
Fax/copier must be version 1.4 or earlier. 

Logging into Your Deltek Time & Expense with Employee Self-
Service 9.0.1 Company Domain 

Purpose 
This step provides instructions for logging into your Deltek Time & Expense with Employee Self-
Service 9.0.1 company domain. 

Where 
This step can be performed from any client that meets the hardware and software prerequisites 
and has TCP/IP access to your WebLogic application server.  

To login to your Deltek Time & Expense with Employee Self-Service 9.0.1 company 
domain, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your WebLogic application server. 

 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/DeltekTC/welcome.msv 

http://10.2.2.54:7001/DeltekTC/welcome.msv
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2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter install. 

 

The Login ID is case-sensitive and MUST be entered in lowercase. 

 Password — Enter password. 

 

The password is case-sensitive. 

 Domain — Enter <Your_Domain_Name>. 

Where: 

<Your_Domain_Name> identifies the company domain you assigned to the 
TC_0002 database schema. 

 Language — Select your language from the drop-down box (for example, 
English/United States). 

3. Click Login. 

4. When the Select Time Zone window displays, accept the default time zone (that is, 
Eastern Standard Time (America/New_York) for the logged-in user (install), or select 
a different time zone from the drop down list, and click OK. 

 

After you select a default time zone for the user, you will no longer be prompted with 
this window. 

5. When the Welcome screen displays, you can begin using the Deltek Time & Expense 
with Employee Self-Service 9.0.1 system. 

 

Please note that if you are planning on fax attaching items to expense reports/expense 
authorizations, the PDF created by Fax/copier must be version 1.4 or earlier. 

 

Deltek Employee Self-Service 9.0.1 users must proceed to “Appendix F: Installing Costpoint 
Interface Programs.”  

You must have Adobe Acrobat Reader installed on any browser client that intends to display or 
print timesheets or any other reports from the Deltek Time & Expense with Employee Self-
Service 9.0.1 system. 
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Hot Fix Bundle Installation 
Several defects were repaired and tested after during the installation release testing. To reduce 
the installation effort applying these, an installation has been created to install the latest files.  
These bundles are released as hot fixes in DSM. You should have been prompted to download 
any hot fixes when you downloaded the software. If not, you will need to go download all hot fixes 
for Time & Expense 9.0.1 now. During this step, you will install the latest Deltek Time & Expense 
with Employee Self-Service 9.0.1 Hot Fix Bundle software. 

Step 1: Installing Deltek Time & Expense with Employee Self-
Service 9.0.1 Hot Fix Bundle 

Purpose  
During this step, you will install the latest Deltek Time & Expense with Employee Self-Service 
9.0.1 Hot Fix Bundle software. 

Where 
This step must be performed on the WebLogic application server that will host your Deltek Time & 
Expense with Employee Self-Service 9.0.1 software. 

To install the latest Deltek Time & Expense with Employee Self-Service 9.0.1 Hot Fix 
Bundle software, complete the following steps: 

1. Run DeltekTimeandExpense901HotFixBundleXXX.exe to launch the latest Deltek 
Time & Expense with Employee Self-Service 9.0.1 Hot Fix Bundle installation program. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer, and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and click Next. 

 

It can take several minutes for the License Agreement screen to display. 

4. When the Choose Install Folder screen displays, select the location of your Time & 
Expense 9.0.1 software. If the default (C:\Oracle\Middleware\DeltekTE90) is not the 
correct location, click Choose to select the correct folder. When you have chosen your 
Time & Expense 9.0.1 folder, click Next. 

 

After you click Next to continue, the program will check the registry to verify that you 
have installed Time & Expense 9.0.1 (9.0.1.0). The installation will not allow you to 
proceed if you have not. 

5. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
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make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

6. When the Install Complete screen displays, click Done to exit the installation. 

7. Review the log file, 
C:\Oracle\Middleware\DeltekTE90\DeltekTimeandExpense901HotFixBundleXXX_Ins
tallLog.log. Scroll down to the Summary section, and report any Warnings, 
NonFatalErrors, or FatalErrors to Deltek Technical Support. 

Step 2: Logging into your Deltek Time & Expense with Employee 
Self-Service 9.0.1 Company Domain 

Purpose 
This step provides instructions for logging into your Deltek Time & Expense with Employee Self-
Service 9.0.1 company domain(s). 

Where 
You can perform this step from any supported browser client that has TCP/IP access to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 

To login to your Deltek Time & Expense with Employee Self-Service 9.0.1 company 
domain, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your WebLogic application server. 

 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/DeltekTC/welcome.msv 

2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter your login ID. 

 

The Login ID is case-sensitive. 

 Password — Enter your login user's password. 

 

The password is case-sensitive. 

 Domain — Enter <Your_Domain_Name>. 

Where: 

http://10.2.2.54:7001/DeltekTC/welcome.msv
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 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0002, TC_0003, TC_0004, TC_0005, and so on, database schema when 
you originally installed the Time & Expense 9.0.1 LA software. 

 Language — Select your language from the drop-down box (for example, 
English/United States). 

3. Click Login. 

4. When the Welcome screen displays, you can begin using the Deltek Time & Expense 
with Employee Self-Service 9.0.1 system. 
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Appendix A: Documentation 
This appendix lists the Time & Expense 9.0.1 documentation and provides a brief description of 
each.  

Online Help 
 The online help is fully updated for Time & Expense 9.0.1. From within Time & Expense 

9.0.1, click  on the Global menu and select Help to open the help topic for the 
currently displayed screen. You can navigate to any help topic from the table of contents 
that displays in the left navigation pane. 

Release Notes 
 DeltekTimeAndExpense901ReleaseNotes.pdf — This document describes version 

9.0.1 enhancements, software corrections, and database changes. 

 

See the 9.0 release notes (DeltekTimeAndExpense90ReleaseNotes.pdf) to learn about 
enhancements, software corrections, and database changes made in the last release that are 
also included in the 9.0.1 installation.  

DeltekTimeAndExpense90ReleaseNotes.pdf is included in the 9.0.1 installation package and 
is also available from Deltek Customer Connect. 

Technical Guides 
 DeltekTimeAndExpense901GettingStartedGuideTimeCollection.pdf — This 

document describes important concepts and how to implement and use Deltek Time. 

 DeltekTimeAndExpense901GettingStartedGuideExpense.pdf — This document 
describes important concepts and how to implement and use Deltek Expense. 

 DeltekTimeAndExpense901GettingStartedGuideEmployeeSelfService.pdf — This 
document describes important concepts and how to implement and use Deltek Employee 
Self Service. 

 DeltekTimeAndExpense901TechnicalGuide.pdf — This document describes a 
technical overview of the system along with valuable materials about the database, 
security, integration, and so on. 

Documentation for Deltek Mobile Time 
Deltek Mobile Time is available to all Web Time customers. 

 DeltekMobileTime901SupplementalInformation.pdf — Attention Deltek Mobile Time 
Customers: Review the information contained in this document before installing Deltek 
Mobile Time. 

 DeltekMobileTime901NewInstallGuide.pdf — This document provides instructions on 
installing and deploying Deltek Mobile Time. 

 DeltekMobileTime901UpgradeInstallGuide.pdf — This document provides instructions 
on installing and deploying Deltek Mobile Time for existing Mobile Time users. 

The linked image cannot be displayed.  The file may have been moved, renamed, or deleted. Verify that the link points to the correct file and location.
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 DeltekMobileTime901LoginScreenQRC.pdf — This document provides a graphical 
overview of logging on to Deltek Mobile Time. 

 DeltekMobileTime901OverviewQRC.pdf — This document provides a graphical 
overview of Deltek Mobile Time. 

 DeltekMobileTime901TimesheetOptionsQRC.pdf — This document provides a 
graphical overview of the mobile timesheet features. 

 DeltekMobileTime901EnterTimesheetInformationQRC.pdf — This document provides 
a graphical overview of entering timesheet data in Deltek Mobile Time. 

 DeltekMobileTime90NavigationQRC.pdf — This document provides a graphical 
overview of navigating Deltek Mobile Time. 

 DeltekMobileTime90UserOptionsQRC.pdf — This document provides a graphical 
overview of user options in Deltek Mobile Time. 

Entity Relationship Diagram (ERD) 
 DeltekTimeAndExpense901ERD.zip — This zip file contains the Deltek Time & 

Expense ERD.  To access the ERD extract all files from the zip and execute the 
following: 

o TE 901 ERD Company Report— Under this folder, launch index.htm to view 
the “Company” schema(s) containing the configuration, master, and transactional 
data for  Deltek Time, Expense, and Employee Self Service. Each domain has 
their own “Company” schema. 

o TE 901 ERD Master Report— Under this folder, launch index.htm to view the 
”Master” schema (TC_0000) containing system data that is common for all T&E 
domains (company data schemas).  It contains user security information, import 
staging tables, and high level T&E domain settings. 

 



Appendix B: Using the Sample Data Domain 

 

New Installation for Microsoft SQL Sever 39 

 

Appendix B: Using the Sample Data Domain 
A sample domain (SAMPLE) has been created to help you familiarize yourself with the Deltek 
Time & Expense with Employee Self-Service 9.0.1 software. The SAMPLE domain is a database 
schema that Deltek provides to help customers familiarize themselves with the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software. The SAMPLE domain is stored in the 
TC_0001 database schema, and it includes a fully functional collection of data for a fictitious 
company.  This appendix provides instructions for connecting to the Deltek Time & Expense with 
Employee Self-Service 9.0.1 SAMPLE domain. 

The procedure in this appendix can be performed from any supported browser client that has 
TCP/IP access to your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic 
application server.  

 

See the “System Requirements” section for a list of supported browser clients. 

To connect to the SAMPLE domain, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server; and 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/DeltekTC/welcome.msv 

2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter 10010. 

 Password — Enter the password for the 10010 user. The default was sample. 

 Domain — Enter SAMPLE. 

 Language — Select your language from the drop-down box (i.e., English/United 
States). 

3. Click the Login button. 

4. When the MyDesktop screen displays, you may begin using the SAMPLE domain to 
familiarize yourself with the Deltek Time & Expense with Employee Self-Service 9.0.1 
software. 

http://10.2.2.54:7001/DeltekTC/welcome.msv
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Appendix C: Using Microsoft’s Internet 
Information Server with Deltek Time & Expense 
with Employee Self-Service 9.0.1 
This appendix provides instructions for integrating your Deltek Time & Expense with Employee 
Self-Service 9.0.1 software with Microsoft’s Internet Information Server. 

The procedures in this appendix must be performed on a Web server that is using Microsoft’s 
Internet Information Server. 

 

This installation will automatically remove all previous versions of the Time & Expense with 
Employee Self-Service software running in IIS. 

Prerequisites 
The Web server that will host your Internet Information Server software must meet the following 
prerequisites: 

 Hardware 

 Hardware requirements vary among the different Web server platforms. Consult with 
Deltek’s Systems Solutions team or your Web server platform vendor to determine 
the hardware requirements for your Web server. 

 Software 

 Microsoft Internet Information Server 7.0. 

Step 1: Installing Deltek Time & Expense 9.0.1 IIS Software 

To install the Deltek Time & Expense 9.0.1 IIS software, complete the following steps: 

1. Run DeltekTimeAndExpense901IIS.exe to launch the Deltek Time & Expense with 
Employee Self-Service 9.0.1 Internet Information Server installation program. 

 

Due to enhanced security in Windows Server 2008 it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the Previous Version of Time & Expense Exists message displays, click OK. 

4. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and click Next. 

 

It can take several minutes for the License Agreement screen to display. 

5. When the Choose Install Folder screen displays, enter the location of your Microsoft IIS 
Web server’s default folder by accepting the default folder (C:\inetpub\wwwroot), or 
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choose a different folder by clicking the Choose button. After you have chosen the 
appropriate folder, click Next. 

6. When the Enter WebLogic System Information screen displays, perform the following: 

 IP Address or Hostname — Enter the IP address (for example, 10.2.2.154) or 
hostname (for example, appsvr01) of your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server. 

 

The IP Address or Hostname cannot be 127.0.0.1 or localhost. 

 Listen Port — Enter the Listen Port for your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server. You specified this port during the 
Deltek Time & Expense with Employee Self-Service 9.0.1 software installation. The 
default port is 7009 (recommended). 

 

Your Microsoft IIS Web server will use the IP address or hostname and listen port 
information to forward requests to your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server. 

7. Click Next. 

8. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

9. When the Install Complete screen displays, click Done to exit the installation. 

10. Review the log file, 
C:\Inetpub\wwwroot\DeltekTC\Time_&_Expense_with_Employee_Self_Service_9.0.
1_Internet_Information_Server_InstallLog.log. Scroll down to the Summary section, 
and report any Warnings, NonFatalErrors, or FatalErrors to Deltek Technical Support. 

Step 2: Configuring IIS for Deltek Time & Expense 9.0.1 
To configure IIS for Deltek Time & Expense 9.0.1, complete the following steps: 

1. Click Start » Administrative Tools » Server Manager. 

2. Expand the Roles tree in the left pane, and click Web Server (IIS). 

3. When the Web Server (IIS) screen displays, click Add Roll Services in the right pane. 

4. When the Select Role Services screen displays, perform the following actions: 

 ISAPI Extensions — Select this check box. 

 Click Next >, and then click Install. 

 

If the ISAPI Extensions have already been installed, click Cancel. 

5. Expand the Web Server (IIS) tree in the left pane, and click Internet Information 
Services (IIS) Manager. 

6. When the Internet Information Services (IIS) Manager screen displays, expand your IIS 
computer name, expand Sites, and expand the Default Web Site node. 
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7. Click the new DeltekTC folder, and double-click Handler Mappings. 

8. When the Handler Mappings screen displays, under Actions in the right pane, click Add 
Script Map…. 

 

If you already have the TEjspProxy and TEmsvProxy script maps created skip to item 
15 of this step. 

9. When the Add Script Map screen displays, perform the following: 

 Requested path — Enter *.jsp. 

 Executable — Enter, or browse to, C:\inetpub\wwwroot\DeltekTC\iisproxy.dll 
(where C:\inetpub\wwwroot\DeltekTC is the directory where your Deltek Time & 
Expense with Employee Self-Service 9.0.1 IIS files were copied). 

 Name — Enter TEjspProxy. 

 Click OK. 

10. When the “Do you want to allow this ISAPI extension?” message displays, click Yes. 

11. When the Handler Mappings screen displays, under Actions in the right pane, click Add 
Script Map.... 

12. When the Add Script Map screen displays, perform the following: 

 Requested path — Enter *.msv. 

 Executable — Enter, or browse to, C:\inetpub\wwwroot\DeltekTC\iisproxy.dll 
(where C:\inetpub\wwwroot\DeltekTC is the directory where your Deltek Time & 
Expense with Employee Self-Service 9.0.1 IIS files were copied). 

 Name — Enter TEmsvProxy. 

 Click OK. 

13. When the “Do you want to allow this ISAPI extension?” message displays, click Yes. 

14. When the Handler Mappings screen displays, under Actions in the right pane, click Add 
Script Map.... 

15. When the Add Script Map screen displays, perform the following: 

 Requested path — Enter *.serv. 

 Executable — Enter, or browse to, C:\inetpub\wwwroot\DeltekTC\iisproxy.dll 
(where C:\inetpub\wwwroot\DeltekTC is the directory where your Deltek Time & 
Expense with Employee Self-Service 9.0.1 IIS files were copied). 

 Name — Enter TEservProxy. 

 Click OK. 

16. When the “Do you want to allow this ISAPI extension?” message displays, click Yes. 

17. Right-click your IIS computer name icon that displays in the left pane of the Internet 
Information Services (IIS) Manager window, and click Stop on the shortcut menu.. 

18. Right-click your IIS computer name icon that displays in the left pane of the Internet 
Information Services (IIS) Manager window, and click Start on the shortcut menu. 

19. Close the Server Manager window. 
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Step 3: Installing IIS Help Files for Deltek Time & Expense 9.0.1 
Company Domains 
To install the IIS help files for your Deltek Time & Expense 9.0.1 company domains, 
complete the following steps: 

1. Open a Windows Command Prompt.  

2. Navigate to the directory where the files that integrate your Deltek Time & Expense 9.0.1 
software with Microsoft’s IIS were installed (C:\inetpub\wwwroot\DeltekTC), and launch 
the following command script: 

TEiisHelp <Your_Domain_Name>  

Where: 

 <Your_Domain_Name> identifies the domain name you will use when logging into 
your Time & Expense company domain. The Domain name cannot contain spaces. 

For example, if your company domain name is ACME, you would enter the following: 

TEiisHelp ACME  

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

When you launch the TEiisHelp <Your_Domain_Name> script, the Windows Command 
Prompt will display the message “Copying files….” If you are prompted with an 
“Overwrite C:\inetpub\wwwroot\DeltekTC\... <Yes/No/All>” message, you must enter Y 
to overwrite your file with the latest one. A “Copy complete…” message will display 
when the copy process finishes. 

3. Launch the TEiisHelp <Your_Domain_Name> command script for each of your other 
company domains. 

4. Close the Windows Command Prompt. 

Step 4: Accessing Deltek Time & Expense 9.0.1 through IIS 
To access Deltek Time & Expense 9.0.1 through IIS, complete the following steps: 

1. You can now access the Deltek Time & Expense with Employee Self-Service 9.0.1 
software by entering the following, case-sensitive, URL in your browser: 

http://<IPAddress or ComputerName>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Microsoft Internet Information Web 
server that will forward requests to your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic application server. 

For example, http://10.2.2.154/DeltekTC/welcome.msv 

 

 

 

http://10.2.2.54/DeltekTC/welcome.msv
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Appendix D: Creating Additional Domains 
This appendix provides instructions for creating additional Deltek Time & Expense with Employee 
Self-Service 9.0.1 company domains. To create a new company domain, you will complete the 
following steps: 

 Create your new company domain 

 Install help files for the new company domain 

 Log in to your new company domain 

Step 1: Creating Additional Deltek Time & Expense with 
Employee Self-Service 9.0.1 Domains 

Purpose 
The Deltek Time & Expense with Employee Self-Service 9.0.1 system requires you to create and 
license each of the database schemas that you plan to use as domains for storing and accessing 
your timesheet data. This step provides instructions for creating and licensing additional Deltek 
Time & Expense with Employee Self-Service 9.0.1 domains. 

Where 
This step must be performed from a machine that has Web browser client access via TCP/IP to 
the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available to download for free at http://java.com.  

To complete this step, you must have access to the DELTEKTE.LIC license file supplied to you 
by Deltek. This is the same license file you used when creating your initial company domain.  

To create and license additional Deltek Time & Expense with Employee Self-Service 9.0.1 
domains, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

http://java.com/
http://10.2.2.54:7001/console


Appendix D: Creating Additional Domains 

 

New Installation for Microsoft SQL Sever 45 

 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

 Click Login. 

3. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (for example, http://10.2.2.154) to your 
Internet Browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the 
note on the previous page for more information. 

4. When the Settings for DeltekTE screen displays, click the Application Configuration 
tab, and then click the Create New Domain link. 

5. When the Database Login screen displays, perform the following: 

 Database Login ID — Accept the default of sa. 

 Database Password — Enter the Microsoft SQL Server sa user’s password. 

6. Click Ok. 

7. When the Deltek Application Configuration Home screen displays, enter the following: 

 Target Version — Accept the default of 9.0.1.0. 

 Schema — Accept the default of the next available database schema (that is, 
TC_0003). 

 Domain Name — Enter the name you want to use to log into your new company 
domain. The domain name is an alias for the TC_000x database schema and will 
typically be shorthand for your company, division, or department name. The domain 
name you choose cannot be greater than 30 characters nor contain spaces. This 
domain name will be referred to as <Your_New_Domain_Name> throughout the 
remainder of these instructions. 

 Domain Password — Enter a password for the database schema being created 
(that is, the TC_0003 schema). 

 Domain Password (Verify) — Re-enter the password. 

 License File — Click Browse, navigate to your 
C:\Oracle\Middleware\DeltekTE90\scripts directory, select the DELTEKTE.LIC file, 
and click Open. If you are not on the WebLogic application server, enter the actual 
location of your license file on the application server (for example, 
C:\Oracle\Middleware\DeltekTE90\scripts\DELTEKTE.LIC). 

 Default Database — Enter your Deltek Time & Expense with Employee Self-Service 
9.0.1 database name. The default is DELTEKTE. 

8. Click Execute to create the new domain. 
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It can take several minutes to create the domain. Upon successful completion, you will 
receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please complete the 
following steps: 

 Execute the following SQL statement in SQL Query Analyzer, connected to 
your DELTEKTE database as the sa user, where <Schema_Name> identifies 
the name of the schema you just created (that is, TC_0003): 

SELECT * FROM <Schema_Name>.DB_SCRIPT_AUDIT 

 Contact Deltek Technical Support. 

9. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. 

10. When the Deltek Application Configuration Home screen displays, under the Connected 
Domain List heading, in the fields that display below the Domain Name heading, click the 
<Your_New_Domain_Name> link. 

11. When the Domain <Your_New_Domain_Name> screen displays, enter the following: 

 Domain Name — Accept the default of <Your_New_Domain_Name>. 

 Schema Name — Accept the default of TC_000x (that is, TC_0003, TC_0004, and 
so on). 

 Status — Accept the default selection of the Enabled option. 

 Locale — Accept the default of English (United States) or change to your preferred 
locale. 

 Company Logo — Enter the directory path location and name of the company logo 
graphics file that will display in the heading of your Deltek Time & Expense with 
Employee Self-Service 9.0.1 reports by performing one of the following: 

 Accept the default directory path location and name of the Deltek supplied 
company logo graphics file: 

/DeltekTC/com/deltek/tc/framework/images/companyLogo.gif 

 Specify your company’s logo graphics file by performing the following: 

a. Copy your company’s logo graphics file to the 
DELTEKTE90\applications\TC\DeltekTC\com\deltek\tc\framework\images 
directory located beneath your WebLogic home folder (that is, 
C:\Oracle\Middleware) on your WebLogic application server. 

b. Enter the following value in the Company Logo field: 

/DeltekTC/com/deltek/tc/framework/images/<Your_Company_Logo.gif> 

Where: 

 <Your_Company_Logo.gif> identifies the name of your company’s logo 
graphics file.  
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For example, if your company’s logo graphics file is named 
MyCompanyLogo.gif, you would copy this file to the 
C:\Oracle\Middleware\DeltekTE90\applications\TC\DeltekTC\com\deltek\t
c\framework\images directory on your WebLogic application server and 
enter the following value in the Company Logo field: 

/DeltekTC/com/deltek/tc/framework/images/MyCompanyLogo.gif 

 The Deltek Time & Expense with Employee Self-Service 9.0.1 
reports will not function properly unless you supply a valid value 
for this field. If you do not have your own company logo 
graphics file, you must specify the Deltek supplied sample file 
by entering 
/DeltekTC/com/deltek/tc/framework/images/companyLogo.g
if. 

 The dimensions for the company logo graphics file are as 
follows: 

 Resizable in width — up to 100 pixels. 

 Resizable in height — up to 50 pixels. 

 Branding Area Graphic — Enter the directory path location and name of the 
branding area graphics file that will display at the top of your Deltek Time & Expense 
with Employee Self-Service 9.0.1 system's Web pages by performing one of the 
following: 

 Accept the default directory path location and name of the Deltek supplied 
branding area graphics file: 

/DeltekTC/com/deltek/tc/framework/images/TC_branding_Area.jpg 

 Specify your company’s branding area graphics file by performing the following: 

a. Copy your company’s branding area graphics file to the 
DELTEKTE90\applications\TC\DeltekTC\com\deltek\tc\framework\images 
directory located beneath your WebLogic home folder (that is, 
C:\Oracle\Middleware) on your WebLogic application server. 

b. Enter the following value in the Branding Area Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/<Your_Branding_Area.jpg> 

Where: 

 <Your_Branding_Area.jpg> identifies the name of your company’s branding 
area graphics file. 



Appendix D: Creating Additional Domains 

 

New Installation for Microsoft SQL Sever 48 

 

 

For example, if your company’s branding area graphics file is named 
MyCompanyBranding.jpg, you would copy this file to the 
C:\Oracle\Middleware\DeltekTE90\applications\TC\DeltekTC\com\deltek\t
c\framework\images directory on your WebLogic application server and 
enter the following value in the Branding Area Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/MyCompanyBranding.gif 

 The dimensions for the branding area graphics file are as 
follows: 

 Resizable in width — up to 780 pixels. 

 Fixed in height — 50/25 pixels (50 pixels above the navigation 
area and 25 pixels above the application name area on the 
Deltek Time & Expense with Employee Self-Service 9.0.1 
system's Web pages). 

For additional information on the branding area graphics file, please see 
the 
DeltekTimeAndExpense83TechnicalGuideTimeAndExpensewithESS.pdf 
file. 

 Splash Screen Graphic — Enter the directory path location and name of the splash 
screen graphics file that will display when users login to your Deltek Time & Expense 
with Employee Self-Service 9.0.1 system by performing one of the following: 

 Accept the default directory path location and name of the Deltek supplied splash 
screen graphics file: 

/DeltekTC/com/deltek/tc/framework/images/splashScreen.gif 

 Specify your company’s splash screen graphics file by performing the following: 

a. Copy your company’s splash screen graphics file to the 
DELTEKTE90\applications\TC\DeltekTC\com\deltek\tc\framework\images 
directory located beneath your WebLogic home folder (that is, 
C:\Oracle\Middleware) on your WebLogic application server. 

b. Enter the following value in the Splash Screen Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/<Your_Splash_Screen.gif> 

Where: 

 <Your_Splash_Screen.gif> identifies the name of your company’s splash 
screen graphics file. 
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For example, if your company’s splash screen graphics file is named 
MyCompanySplash.gif, you would copy this file to the 
C:\Oracle\Middleware\DeltekTE90\applications\TC\DeltekTC\com\deltek\t
c\framework\images directory on your WebLogic application server and 
enter the following value in the Splash Screen Graphic field: 

/DeltekTC/com/deltek/tc/framework/images/MyCompanySplash.gif 

 The dimensions for the splash screen graphics file are as 
follows: 

 Resizable in width — up to 680 pixels. 

 Resizable in height — up to 335 pixels. 

For additional information on the splash screen graphics file, refer to the 
DeltekTimeAndExpense83TechnicalGuideTimeAndExpensewithESS.pdf 
file. 

 Authentication Method — Select the authentication method you want to use: 
Database, LDAP, or SSO. The default is Database. 

 

Select LDAP if your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic server will be working with a Microsoft Active Directory Lightweight 
Directory Access Protocol (LDAP) server. 

 Login ID Source — Select the type of login you want to use: LOGIN_ID or 
CONTEXT_ID. The default is LOGIN_ID. 

 Case Sensitive Login ID — Select this check box to make your login case-sensitive. 
This check box is selected by default. To log into all new domains that you create as 
the install user, you must select this check box. 

 Mixed Case Password — Accept the default. 

 Attachment Storage Method — Select the method of storage for expense 
attachments: File System (default) or Database. 

 Export Location — Accept the default. 

 Import Location — Accept the default. 

 Trash Location — Accept the default. 

 Traveler Import Location — Accept the default. 

 Traveler Rejection Location — Accept the default. 

 Traveler Examination Level — Accept the default of 1 - fastest. 

 Save Login Id to Cookie — Accept the default. 

 Save Domain to Cookie — Accept the default. 

 Receipt Storage Location — Accept the default. 

 Mobile Message Bundle Location — Accept the default. 

 Employee Password Self Reset — Accept the default. 

 English (United States) — Accept the default. 

 System Email Address — Accept the default. 

 Time Sender Email Address — Accept the default. 

 Expense Sender Email Address — Accept the default. 
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 ESS Sender Email Address — Accept the default. 

 SMTP Server Name — Accept the default. 

 SMTP Port — Accept the default. 

 SMTP User ID — Accept the default. 

 SMTP Password — Accept the default. 

 Timesheet Pre Save — Accept the default. 

 Timesheet Post Save — Accept the default. 

 Timesheet Pre Sign — Accept the default. 

 Timesheet Post Sign — Accept the default. 

 Timesheet Pre Approve — Accept the default 

 Timesheet Post Approve — Accept the default. 

 ER Pre Sign — Accept the default. 

 ER Post Sign — Accept the default. 

 ER Pre Save — Accept the default. 

 ER Post Save — Accept the default. 

 EA Pre Save — Accept the default. 

 EA Post Save — Accept the default. 

 EA Pre Sign — Accept the default. 

 EA Post Sign — Accept the default. 

12. Click Save Changes. 

 

When the Update Domain <Your_New_Domain_Name> screen displays, you will 
receive the following message: 

Process Completed Successfully! 

If you receive any error codes instead of the above message, please contact Deltek 
Technical Support. 

 

You may not be able to immediately log into your new Deltek Time & Expense with 
Employee Self-Service 9.0.1 domain. You must wait several minutes for the system to 
recognize the new domain. 

13. When the “Process Completed Successfully!” message displays, click the Deltek 
Application Configuration Home link that displays near the bottom of the screen. 

14. Close the Web browser screen. 

Step 2: Installing Help Files for Deltek Time & Expense 9.0.1 
Company Domains 

Purpose 
This step provides instructions for installing the help files for your Deltek Time & Expense 9.0.1 
company domains. 
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Where 
This step must be performed on your Deltek Time & Expense 9.0.1 WebLogic application server. 

To install the help files for your Deltek Time & Expense 9.0.1 company domains, complete 
the following steps: 

1. Open a Windows Command Prompt and launch the following command script: 

TEHelpFiles <Your_Domain_Name> 

Where: 

 <Your_Domain_Name> identifies the domain name you will use when logging into 
your Time & Expense company domain. The domain name cannot contain spaces. 

For example, if your company domain name is ACME, you would enter the following: 

TEHelpFiles ACME 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

When you launch the TEHelpFiles <Your_Domain_Name> script, the Windows 
Command Prompt will display the message “Copying files….” If you are prompted with 
an “Overwrite C:\Oracle\Middleware\DeltekTE90\... <Yes/No/All>” message, you must 
enter Y to overwrite your file with the latest one. A “Copy complete…” message will 
display when the copy process is finished. 

2. Close the Windows Command Prompt. 

Step 3: Installing IIS Help Files for Deltek Time & Expense 9.0.1 
Company Domains 

Purpose 
This step provides instructions for installing the help files for your Deltek Time & Expense 9.0.1 
company domains on your Microsoft IIS Web server. 

 

You must skip this step if you are not running Deltek Time & Expense 9.0.1 with Microsoft IIS. 

Where 
You must perform this step on your Deltek Time & Expense 9.0.1 Microsoft IIS web server. 

To install the IIS help files for your Deltek Time & Expense 9.0.1 company domains, 
complete the following steps: 

1. Open a Windows Command Prompt, navigate to the directory where the files that 
integrate your Deltek Time & Expense 9.0.1 software with Microsoft’s IIS were installed 
(C:\inetpub\wwwroot\DeltekTC), and launch the following command script: 

TEiisHelp <Your_Domain_Name> 

Where: 
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 <Your_Domain_Name> identifies the domain name you will use when logging into 
your Time & Expense company domain. The domain name cannot contain spaces. 

For example, if your company domain name is ACME, you would enter the following: 

TEiisHelp ACME 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

When you launch the TEiisHelp <Your_Domain_Name> script, the Windows Command 
Prompt will display the message “Copying files….” If you are prompted with an 
“Overwrite C:\inetpub\wwwroot\DeltekTC\... <Yes/No/All>” message, you must enter Y 
to overwrite your file with the latest one. A “Copy complete…” message will display 
when the copy process is finished. 

2. Close the Windows Command Prompt. 

Step 4: Logging in to Additional Domains 

Purpose 
This step provides instructions for logging into your new Deltek Time & Expense with Employee 
Self-Service 9.0.1 company domain. 

Where 
This step can be performed from any supported browser client that has TCP/IP access to your 
WebLogic application server.  

 

See the System Requirements section for a list of supported browser clients. 

To login to your new Deltek Time & Expense with Employee Self-Service 9.0.1 company 
domain, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/DeltekTC/welcome.msv 

2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter install. 

http://10.2.2.54:7001/DeltekTC/welcome.msv
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The Login ID is case-sensitive and MUST be entered in lowercase. 

 Password — Enter password. 

 

The password is case-sensitive and MUST be entered in lowercase. 

 Domain — Enter <Your_New_Domain_Name>. 

Where: 

 <Your_New_Domain_Name> identifies the company domain you assigned to 
the TC_000x (that is, TC_0003) database schema in Step 1 of this appendix. 

 Language — Select your language from the drop-down box (for example, 
English/United States). 

3. Click Login. 

4. When the Select Time Zone window displays, for the logged in user (that is, install) 
accept the default time zone (that is, Eastern Standard Time (America/New_York) or 
select a different time zone from the drop down list, and click OK. 

 

After you select a default time zone for the user, you will no longer be prompted with 
this window. 

5. When the Welcome screen displays, you can begin configuring and using the Deltek 
Time & Expense with Employee Self-Service 9.0.1 system. 
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Appendix E: Starting/Stopping Deltek Time & 
Expense with Employee Self-Service 9.0.1 
WebLogic Server 
This appendix discusses the following methods for starting and stopping your Deltek Time & 
Expense with Employee Self-Service 9.0.1 WebLogic Server: 

 Starting the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 

 As a Windows service 

 From the Windows Start menu 

 From a Windows Command Prompt 

 Stopping the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 

 As a Windows service 

 From a Web browser 

Starting the WebLogic Server 

As Windows Service 

Purpose 

This step provides instructions for starting your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server as a Windows service. 

Where 

This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To start your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
when it is installed as a Windows service, complete the following steps: 

1. Click Start » Programs » Administrative Tools » Services. 

2. When the Services window displays, scroll down the Services list to find the Time & 
Expense with ESS 9.0.1 service. Right-click the Time & Expense with ESS 9.0.1 
service, and click Properties on the shortcut menu. 

3. When the Time & Expense with ESS 9.0.1 Properties screen displays, click the General 
tab. 

4. Click Start to start the Time & Expense with ESS 9.0.1 service. 

 

The service will indicate that it started immediately. Please note, however, that it will 
take several minutes for the Time & Expense with ESS 9.0.1 service to fully initialize. 
After starting the service, you must wait several minutes before attempting to connect 
to the software. If you encounter problems with the Time & Expense with ESS 9.0.1 
service, check the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log file 
and report any errors to Deltek Technical Support. 

5. Click OK to close the Time & Expense with ESS 9.0.1 Properties screen. 
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6. Close the Services window. 

From Start Menu 

Purpose 

This step provides instructions for starting your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server from the Windows Start menu. 

Where 

This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To start your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
from the Windows Start menu, complete the following steps: 

1. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. A Windows Command Prompt displays and a 
command script automatically launches that starts the WebLogic server. You will see a 
series of messages scrolling down the Windows Command Prompt screen. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

It will take several minutes for the Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server to start. 

2. If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server starts 
successfully, the following message displays near the bottom of the command line shell 
window: 

“<The server started in RUNNING mode. >” 

 

If your WebLogic server encounters errors during the startup process, the “<The server 
started in RUNNING mode.>” message will not display and the Windows Command 
Prompt may terminate. 

If you do not receive this message or the Windows Command Prompt terminates, you 
must do the following tasks: 

1. Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServ
er.log file. 

2. Contact Deltek Technical Support. 

From Windows Command Prompt 

Purpose 

This step provides instructions for starting your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server from a Windows Command Prompt. 

Where 

This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 
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To start your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
from a Windows Command Prompt, complete the following steps: 

1. Open a Windows Command Prompt and launch the following command script: 

StartTE90 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching this command even when the logged in user 
has local administrative rights. 

It will take several minutes for the Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server to start. 

You will see a series of messages scrolling down the screen. 

2. If your WebLogic server starts successfully, the following message will display near the 
bottom of the command line shell window: 

“<The server started in RUNNING mode.>” 

 

If your WebLogic server encounters errors during the startup process, the “<The server 
started in RUNNING mode.>” message will not display. 

If you do not receive this message, you must do the following tasks: 

1. Locate the actual error by scrolling up in the Windows Command Prompt 
screen until you see the WebLogic server error message. 

2. Document the error message. 

3. Contact Deltek Technical Support. 

Stopping the WebLogic Server 

As Windows Service 

Purpose 

This step provides instructions for stopping your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server when it is running as a Windows service. 

Where 

This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To stop your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
when it is installed as a Windows service, complete the following steps: 

1. Click Start » Programs » Administrative Tools » Services. 

2. When the Services window opens, scroll down the Services list to find the Time & 
Expense with ESS 9.0.1 service. Right-click the Time & Expense with ESS 9.0.1 
service, and click Properties on the shortcut menu. 

3. When the Time & Expense with ESS 9.0.1 Properties screen displays, click the General 
tab. 

4. Click Stop to stop the Time & Expense with ESS 9.0.1 service. 

5. Click OK to close the Time & Expense with ESS 9.0.1 Properties screen. 
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6. Close the Services window. 

From Web Browser 

Purpose 

This step provides instructions for stopping your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server from the WebLogic console. 

Where 

This step must be performed from a machine that has Web browser client access via TCP/IP to 
the WebLogic application server. Microsoft’s Java Virtual Machine (MSJVM) or Sun 
Microsystems’ Java™ Virtual Machine (JVM™) must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available to download for free at http://java.com. 

To stop your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
from a Web browser, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your WebLogic application server uses to 
listen for connections. You specified this port value during the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

3. Click Login. 

4. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It may take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (for example, http://10.2.2.154) to your 
Internet Browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the 
note on the previous page for instructions. 

5. When the Settings for DeltekTE screen displays, click the Control tab, and perform the 
following: 

http://java.com/
http://10.2.2.54:7001/console
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 DeltekTEServer (admin) — Select the check box that displays to the left. 

6. Click Shutdown, and then select Force Shutdown Now. 

7. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

8. Close the Web browser screen. 

 

It can take several minutes for your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic Server to process the shutdown request. 

The shutdown request has completed if either of the following conditions on your WebLogic 
application server is true: 

 The Windows Command Prompt that was used to launch your Deltek Time & Expense 
with Employee Self-Service 9.0.1 WebLogic Server has terminated. 

 The status of the Deltek Time & Expense with Employee Self-Service 9.0.1 Windows 
service that was used to start your Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server has changed from Started to blank. 
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Appendix F: Installing Costpoint Interface 
Programs 
This appendix provides instructions for copying the Costpoint interface programs to your 
Costpoint programs directory (that is, Y:\CP61 or C:\CP70). It also provides instructions for 
applying updates to your Costpoint database (that is, DELTEKCP). 

 

The steps in this appendix must be performed by all Deltek Time & Expense with Employee 
Self-Service 9.0.1 clients that interface into Costpoint, including all Deltek Employee Self-
Service 9.0.1 clients.  

The procedures in this appendix must be performed on a computer that has write access to your 
Costpoint directory. 

Prerequisites 
 Time — The following must be installed: 

 Costpoint version 6.1 with Service Pack 2 or Costpoint version 7.0 

 Expense — The following must be installed: 

 Costpoint version 6.1 with Service Pack 2 or Costpoint version 7.0 

 Self-Service — The following must be installed: 

 Costpoint version 6.1 with Service Pack 2 or Costpoint version 7.0 

 If you are an existing Costpoint ESS user, your Costpoint database must be at ESS 
3.1, or higher, level. 

Step 1: Accessing Costpoint Interface Documents 
This step provides instructions for accessing the Deltek Time & Expense with Employee Self-
Service 9.0.1 to Costpoint Interface documents described in the following table. 

Title Description 

DeltekTimeAndExpense90CostpointCorrections.doc This document details the 
enhancements and corrections to the 
Costpoint software included with this 
Deltek Time & Expense with 
Employee Self-Service 9.0.1 release. 

To access the Deltek Time & Expense with Employee Self-Service 9.0.1 Costpoint 
documents, complete the following step: 

1. Open DeltekTimeAndExpense90CostpointCorrections.doc. 
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Step 2: Installing Costpoint Programs 

Purpose 
This step provides instructions for installing the Deltek Time & Expense with Employee Self-
Service 9.0.1 to Costpoint Interface files. 

Where 
For Costpoint 6.1 SP2 users, this step must be performed from a computer that has write 
access to your Costpoint 6.1 SP2 directory. 

For Costpoint 7.0 users, you must perform this step on your Costpoint 7.0 WebLogic 
application server. 

To install the Costpoint program files, complete the following steps: 

1. Run DeltekTimeAndExpense90CostpointInterface.exe to launch the Deltek Time & 
Expense with Employee Self-Service 9.0.1 to Costpoint Interface installation program. 

 

Due to enhanced security in Windows Server 2008, it is advised to use the option to 
Run as Administrator when launching the installation executables even when the 
logged in user has local administrative rights. This option is accessed by right-clicking 
the installation executable file name in Windows Explorer and selecting Run as 
Administrator to launch the program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and then click Next. 

 

It can take several minutes for the License Agreement screen to display. 

4. When the Choose Database Platform screen displays, click the Microsoft SQL Server 
button, and then click Next. 

5. When the Choose Costpoint Version screen displays, perform the following: 

 Costpoint version 6.1 SP2 — Select this option if you are running Costpoint version 
6.1 SP2. 

 Costpoint version 7.0 — Select this option if you are running Costpoint version 7.0. 

Click Next. 

6. When the Choose Install Folder screen displays, indicate where you would like to install 
the Costpoint files by accepting the default folder (C:\CP61 or C:\CP70), or choose a 
different folder by clicking Choose. After you have chosen the folder, click Next. 

 

For Costpoint 6.1 SP2 clients, this should be your Costpoint client/server programs 
directory. 

For Costpoint 7.0 clients, this can be any directory.  You will apply the installed files 
from this directory in the next step. 

7. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any parameters, click Previous to go back and 
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make the necessary changes. If you are satisfied with these parameters, click Install to 
begin the installation. 

8. When the Install Complete screen displays, click Done to exit the installation. 

Step 3: Applying Costpoint 7.0 Database Updates 

Purpose 
This step provides instructions for applying the Deltek Time & Expense with Employee Self-
Service 9.0.1 Costpoint 7.0 database scripts to your Costpoint 7.0 TRANSACTION database. 

 

You must skip this step if you are running Costpoint 6.1 SP2.  

Where 
You must perform this step on your Costpoint 7.0 WebLogic application server. 

To apply the scripts, complete the following steps: 

1. Click Start » All Programs » Costpoint 7.0 » Start Costpoint 7.0 DBWizard to open 
the Costpoint 7.0 Database Wizard. The Costpoint DB Wizard screen displays. 

2. Perform the following: 

 Available options — Select Apply Script. 

 Click Next. The Select Schema screen displays. 

3. Perform the following: 

 System — Select your Costpoint 7.0 database (for example, DELTEKCP) from the 
drop-down list. 

 Schema — Select DATA from the drop-down list. 

 Verify the default values of the following fields: 

 DB Platform — Accept the default of SQLSERVER. 

 Server — Accept the default of your Database Server IP address or hostname. 

 Port — Accept the default port (for example, 1433). 

 Instance/Database — Accept the default of your Costpoint database name. 

 User — Accept the default of DELTEK. 

 Password — Accept the default of your DELTEK user password. 

 URL — Accept the default of your Microsoft SQL Server connect string. 

4. Click Next. The Script Parameters screen displays. 

5. Perform the following: 

 Selection Mode — Select Folder. 

 Script folder — Click , and perform the following: 



Appendix F: Installing Costpoint Interface Programs 

 

New Installation for Microsoft SQL Sever 62 

 

 File Name — Select the folder where you installed the Costpoint interface files 
(for example, C:\CP70). 

 Files of Type — Accept the default of Select SQL Script Folder. 

 Click Select. 

 Log File — Click , and perform the following: 

 File Name — Enter a log file name. 

 Files of Type — Accept the default of Select LOG file or folder (*.log). 

 Click Select. 

 Schema Replace Mode — Select the Off option. 

 Execution Settings — Select the Stop on error option. 

6. Click Next. The Summary screen displays. 

7. Verify the default values of the following fields: 

 DB Platform — Displays SQLSERVER. 

 DB Server — Displays your Database Server IP address or hostname. 

 DB Instance — Displays your Costpoint database name. 

 DB Port — Displays your listening port (1433). 

 DB Schema — Displays DELTEK. 

 Script File — Displays the file and folder location of your script. 

 Log File — Displays the name and location of your log file. 

 Schema Mode — Displays Off. 

 Exec Settings — Displays either Ignore errors or Stop on error. 

8. Click Run. The following message displays: 

Run Script completed without errors in X second(s). Would you like to run another 
script against this database? 

9. Click No. The Summary screen displays. 

10. Click Cancel. The Costpoint DB Wizard screen displays. 

11. Click Exit. 

Step 4: Applying Costpoint 6.1 SP2 Database Update 

Purpose 
This step provides instructions for applying the Deltek Time & Expense with Employee Self-
Service 9.0.1 Costpoint 6.1 SP2 database scripts to your Costpoint 6.1 SP2 database. 

 

You must skip this step if you are running Costpoint 7.0.  
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Where 
This step must be performed on a Windows client workstation that meets the following 
requirements: 

 The Costpoint 6.1 SP2 Database Wizard (Costpoint DBWizard) has previously been 
installed. 

 You must have Administrative access to your Costpoint 6.1 SP2 DELTEKCP database. 

To apply the script, complete the following steps: 

1. Click Start » All Programs » Costpoint 6.1 SP2 » Costpoint DBWizard. The Costpoint 
DBWizard screen displays. 

2. Perform the following: 

 What would you like to do — Select Apply CSP. 

 Click Next. 

The Costpoint DBWizard: CSP Select Schema screen displays. 

3. Perform the following: 

 System — Select your Costpoint 6.1 database (for example, DELTEKCP) from the 
drop-down list. 

 Schema — Select DATA from the drop-down list. 

 Verify the default values of the following fields: 

 DB Platform — Accept the default of SQLSERVER. 

 Server — Accept the default of your Database Server IP address or hostname. 

 Port — Accept the default port (for example, 1433). 

 Instance/Database — Accept the default of your Costpoint database name. 

 User — Accept the default of DELTEK. 

 Password — Accept the default of your DELTEK user password. 

 URL — Accept the default of your Microsoft SQL Server connect string. 

 Click Next. 

The Costpoint DBWizard: CSP CSP Parameters screen displays. 

4. Perform the following: 

 cspfiles.lst Folder — Click , and perform the following: 

 File Name — Accept the default of your Costpoint database scripts location (for 
example, Y:\CP61). 

 Files of Type — Accept the default of CSPFILES.LST script or folder. 

 Click Select. 

 Log file — Click , and perform the following: 

 File Name — Enter a log file name. 

 Files of Type — Accept the default of Select LOG file or folder (*.log). 
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 Click Select. 

 Execution Settings — Perform the following: 

 Stop on error — Select this option to have the Costpoint DBWizard stop when it 
finds an error. (Deltek recommends using this option when performing your “live” 
upgrade.) 

 Ignore errors — Select this option to have the Costpoint DBWizard ignore all 
errors. (Deltek recommends using this option when performing a test upgrade.) 

 

Deltek recommends running through a test upgrade first with Ignore errors 
selected. This will help you identify any problem areas that may be 
encountered during the actual upgrade.  

If you select this method and have errors, you will need to restore your 
database, fix any errors found, and then run through the upgrade again. 

 Purge Audit table — The Audit Tables store a history of the errors you 
encountered while running the Costpoint DBWizard. If the Audit Tables are not 
purged after restarting a patch installation, any errors from previous installation 
attempts will be reported. Select this check box to purge the audit table. This 
check box is not selected by default. 

 Click Next. 

The Costpoint DBWizard: CSP Summary screen displays. 

5. Perform the following: 

 

When the Costpoint DBWizard opens for Apply CSP, the Applied patches group box 
will list all of the patches that have been previously applied to your database. The 
Patches to be applied group box will list those patches that this installation will apply. 

The required patches that this installation will install, if they have not been previously 
installed, are as follows: 

For Costpoint 6.1 SP2: 

aavaltess.mss and ESS_VER.sql 

The Costpoint DBWizard will halt whenever errors are encountered while applying the 
patches, scripts, stored procedures, and so on, necessary to update your database. 
Any file that stops on an error will be completed by the Costpoint DBWizard upon 
restart, but the line that gave the error will need to be manually completed. 
Please contact Deltek Costpoint Technical Support if these errors occur. 

Please report all errors to Deltek Costpoint Technical Support. 

 Verify the default values of the following fields (they default based on your entries in 
item 3 above) : 

 DB Platform — Displays SQLSERVER. 

 DB Server — Displays your Database Server IP address or hostname. 

 DB Instance — Displays your Costpoint database name. 

 DB Port — Displays your listening port (for example, 1433). 

 DB Schema — Displays DELTEK. 

 Script File — Displays the folder location of your CSPFILES.LST file (for 
example, Y:\CP61). 
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 Log File — Displays the name and location of your log file (for example, 
Y:\CP61\logs\CP61SP2.log). 

 CSPFILES.LST Folder — Shows the folder location of your CSPFILES.LST file 
(for example, Y:\CP61\). 

 Exec Settings — Displays Ignore errors or Stop on error and Purge audit 
table: NO or YES. 

 Click Run to begin updating your Costpoint 6.1 database. Clicking this button will 
produce one of the results/messages found in the following table. Match the result or 
message you receive with the appropriate required action from the following table. 

Result/Message Action 

A SQL Error message displays – “The 
script did not complete because an error 
was encountered. The application will 
display a report listing the error found.” 
When you click OK the following 
message displays – “CSP stopped with 
errors. The application will display a 
report listing the errors found. The CSP 
process can be restarted once the 
statement containing the error has been 
executed manually.” 

Click OK. A report listing the error will 
open. Please have this report ready and 
contact Deltek Costpoint Technical 
Support for further assistance. 

This script will proceed from the line 
following the error. The line that has the 
error will need to be manually completed 
once the error has been resolved. 

After the issues are resolved, click Next 
on the Costpoint DBWizard: CSP 
Parameters screen or, if you have exited 
the Costpoint DBWizard, you will need 
to choose Apply CSP from the What 
would you like to do list box and 
continue from Step 2 of Performing 
Database Update. 

A Process Complete message displays: 
“Process completed without errors. An 
error file will not be generated since 
DBWizard completed without errors.” 

Your database update has successfully 
completed. On the Process Complete 
screen, click OK and proceed to Step 6 
of Performing Database Update. 

A Process Complete message displays: 
“Process completed with errors.” 

Your database update has completed; 
however, a report will open listing the 
errors that were encountered and 
successfully addressed during the CSP 
process. It may also show messages 
that indicate other actions that need to 
be taken (for example, programs that 
may need to be manually copied from 
the CD to your installed directories). 
Once all of these errors have been 
addressed, on the Process Complete 
screen, click OK and proceed to Step 6 
of Performing Database Update.  

6. When the “Process completed without errors” message displays, click OK. 

7. When the “CSP completed without errors in X second(s). Would you like to run another 
process using the Database Wizard?” message displays, click Yes. The Costpoint 
DBWizard screen displays. 
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8. Click Exit. 

Step 5: Executing Costpoint Group Rates in Labor History 
Toolkit 

Purpose 
This step provides instructions for executing a toolkit that prepares your Costpoint system to use 
the current version of the Post Vouchers function. 

Where 
You must perform this step on a Windows client workstation that can access your Costpoint 
database using the Costpoint software. 

To update your Costpoint system, complete the following steps: 

1. Log into Costpoint. 

2. In Costpoint 6.1 SP2, click Projects » Cost and Revenue Processing » Utilities » 
Miscellaneous Toolkits » Group Duplicates in Labor History. 

3. In Costpoint 7.0, click Projects » Cost and Revenue Processing » Administration 
Utilities » Group Duplicates in Labor History. 

4. When the Group Duplicates in Labor History screen displays, complete this step: 

 Fiscal Year — Select your current fiscal year from the drop-down list. 

5. Click Execute and then, after you execute all your fiscal years, click Cancel. 

6. Close the Costpoint Menu screen. 

7. Exit Costpoint. 

Step 6: Applying Costpoint 7.0 ESS License 

Purpose 
This step includes instructions for applying the Employee Self-Service (ESS) license to your 
Costpoint 7.0 TRANSACTION database. This step will need to be performed by any clients that 
are new to Costpoint Employee Self-Service. 

 

You must skip this step if you are running Costpoint 6.1 SP2.  

 

You must skip this step if you are any of the following: 

 Not a Deltek Time & Expense with Employee Self-Service 9.0.1 Self-Service user 

 Using Deltek Employee Self-Service 9.0.1 and are currently a Costpoint ESS 3.1 user 

Where 
You must perform this step on your Costpoint 7.0 WebLogic application server. 

To apply the script, complete the following steps: 
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1. Click Start » All Programs » Costpoint 7.0 » Start Costpoint 7.0 DBWizard to open 
the Costpoint 7.0 Database Wizard. The Costpoint DB Wizard screen displays. 

2. Perform the following: 

 Available options — Select Apply License. 

 Click Next. The Select System screen displays. 

3. Perform the following: 

 System — Select your Costpoint 7.0 database (for example, DELTEKCP) from the 
drop-down list. 

4. Click Next. The Select license file screen displays. 

5. Perform the following: 

 License file — Click , and perform the following: 

 File Name — Select the License.zip file you were provided. 

 Files of Type — Accept the default of Select SQL Script Folder. 

 Click Select. 

 Log File — Click , and perform the following: 

 File Name — Enter a log file name. 

 Files of Type — Accept the default of Select LOG file or folder (*.log). 

 Click Select. 

6. Click Run. The following message displays: 

License file applied successfully. 

7. Click OK. The Select license file screen displays. 

8. Click Cancel. The Costpoint DB Wizard screen displays. 

9. Click Exit. 

Step 7: Applying Costpoint 6.1 SP2 ESS License 

Purpose 
This step includes instructions for applying the Employee Self-Service (ESS) license to your 
Costpoint 6.1 SP2 database. This step will need to be performed by any clients that are new to 
Costpoint Employee Self-Service. 

 

You must skip this step if you are running Costpoint 7.0.  

 

You must skip this step if you are any of the following: 

 Not a Deltek Time & Expense with Employee Self-Service 9.0.1 Self-Service user 

 Using Deltek Employee Self-Service 9.0.1 and are currently a Costpoint ESS 3.1 user 
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Where 
This step must be performed on a Windows client workstation that meets the following 
requirements: 

 The Costpoint 6.1 SP2 Database Wizard (Costpoint DBWizard) has previously been 
installed. 

 You must have Administrative access to your Costpoint 6.1 SP2 DELTEKCP database. 

To license your database for ESS, complete the following steps: 

1. Click Start » All Programs » Costpoint 6.1 SP2 » Costpoint DBWizard. The Costpoint 
DBWizard screen displays. 

2. Perform the following: 

 What would you like to do — Select Apply Script. 

 Click Next. The Costpoint DBWizard: Run Script screen displays. 

3. Perform the following: 

 System — Select your Costpoint 6.1 database (for example, DELTEKCP) from the 
drop-down list. 

 Schema — Select DATA from the drop-down list. 

 Verify the default values of the following fields: 

 DB Platform — Accept the default of SQLSERVER. 

 Server — Accept the default of your Database Server IP address or hostname. 

 Port — Accept the default port (for example, 1433). 

 Instance/Database — Accept the default of your Costpoint database name. 

 User — Accept the default of DELTEK. 

 Password — Accept the default of your DELTEK user password. 

 URL — Accept the default of your Microsoft SQL Server connect string. 

4. Click Next. The DBWizard: Run Script Parameters screen displays. 

5. Perform the following: 

 Selection Mode — Select Single Script. 

 Script file — Click , and perform the following: 

 File Name — Select the license.sql file (from the Y:\CP61 directory). 

 Files of Type — Accept the default of Select SQL Script (*.sql). 

 Click Select. 

 Log File — Click , and perform the following: 

 File Name — Enter a log file name. 

 Files of Type — Accept the default of Select LOG file or folder (*.log). 

 Click Select. 

 Schema Replace Mode — Select the Off option. 
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 Execution Settings — Select the Stop on error option. 

6. Click Next. The Costpoint DBWizard: Run Script Summary screen displays. 

7. Verify the default values of the following fields: 

 DB Platform — Displays SQLSERVER. 

 DB Server — Displays your Database Server IP address or hostname. 

 DB Instance — Displays your Costpoint database name. 

 DB Port — Displays your listening port (1433). 

 DB Schema — Displays DELTEK. 

 Script File — Displays the file and folder location of your script. 

 Log File — Displays the name and location of your log file. 

 Schema Mode — Displays Off. 

 Exec Settings — Displays either Ignore errors or Stop on error. 

8. Click Run. The following message displays: 

“Run Script completed without errors in X second(s). Would you like to run another script 
against this database?” 

9. Click No. 

10. When the Costpoint DBWizard screen displays, click Exit. 

Step 8: Applying Deltek Time & Expense with Employee Self-
Service 9.0.1 License 
This step provides instructions for applying the Deltek Time & Expense with Employee Self-
Service 9.0.1 license to your Deltek Time & Expense with Employee Self-Service 9.0.1 domains. 

 

You must skip this step if you are not a Deltek Time & Expense with Employee Self-Service 
9.0.1 Self-Service user. 

Where 
This step must be performed from a machine that has Web browser client access via TCP/IP to 
the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com.  

To complete this step, the computer on which you are performing this step must have access to 
the Deltek Time & Expense with Employee Self-Service 9.0.1 License file, DELTEKTE.LIC, that is 
contained in the C:\Oracle\Middleware\DeltekTE90\scripts directory.  

To apply the new license to your Deltek Time & Expense with Employee Self-Service 9.0.1 
domains, complete the following steps: 

http://java.com/


Appendix F: Installing Costpoint Interface Programs 

 

New Installation for Microsoft SQL Sever 70 

 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

3. Click Login. 

4. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (that is, http://10.2.2.154) to your Internet 
browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the previous 
note for more information. 

5. When the Settings for DeltekTE screen displays, click the Application Configuration 
tab, and in the fields that display below the Domain Name heading, click the 
<Your_Domain_Name> link for the Database Schema (that is, TC_0002, TC_0003, and 
so on) that requires the new license. 

Where: 

 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0002, TC_0003, or TC_0004, and so on database schema when you originally 
installed the Deltek Time & Expense with Employee Self-Service 9.0.1 software. 

6. When the Database Login screen displays, perform the following: 

 Database Login ID — Accept the default of system (Oracle users) or sa (Microsoft 
SQL Server users). 

 Database Password — Enter the database login user’s password. 

7. Click Ok. 

8. When the Domain <Your_Domain_Name> screen displays, click the Apply License link, 
and perform the following: 

 License File — Click Browse, navigate to your 
C:\Oracle\Middleware\DeltekTE90\scripts directory, select the DELTEKTE.LIC file, 
and click Open. If you are not on the WebLogic application server, enter 
C:\Oracle\Middleware\DeltekTE90\scripts\DELTEKTE.LIC. 
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9. Click Continue to read the new license. 

10. When the Apply License for <Your_Domain_Name> screen redisplays, review the 
following: 

 Company Name — Displays your company name. 

 TimeCollection Web — Displays your number of Seat and/or Transaction licenses 
for Time. 

 ExpenseCollection Web — Displays your number of Seat and/or Transaction 
licenses for Expense. 

 TimeCollection IVR — Displays your number of Seat and/or Transaction licenses for 
Time Interactive Voice Recognition. 

 Web Self-Service — Displays your number of Seat and/or Transaction licenses for 
Self-Service. 

 BlackBerry Time — Displays your number of Seat and/or Transaction licenses for 
BlackBerry Time. 

 Expense Authorization — Displays your number of Seat and/or Transaction 
licenses for Expense Authorization. 

11. Click Execute to apply the new license. 

 

It can take some time to apply the license. 

Upon successful completion, you will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please contact Deltek 
Technical Support. 

12. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. 

 

You must repeat items 5 through 12 of this step for all of your remaining Company 
Domains (that is, schemas TC_0003, TC_0004, TC_0005, and so on) that need the 
new license applied. 

If you are immediately proceeding to the next step, you do not need to close the Web 
browser. You can proceed directly to item 4 of the next step. 

13. Close the Web browser screen. 

Step 9: Creating Costpoint Connection Pools for Self-Service 

Purpose 
This step provides instructions for creating the Costpoint connection pool for Deltek Employee 
Self-Service 9.0.1. The connection pool will provide the Deltek Time & Expense with Employee 
Self-Service 9.0.1 software the connectivity to your Costpoint database. 

 

You must skip this step if you are not a Deltek Time & Expense with Employee Self-Service 
9.0.1 Self-Service user. 
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Where 
This step must be performed from a machine that has Web browser client access via TCP/IP to 
the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com. 

To create a Costpoint connection pool for Self-Service, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

3. Click Login. 

4. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (that is, http://10.2.2.154) to your Internet 
browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the note on 
the previous page for more information. 

5. When the Settings for DeltekTE screen displays, click the Application Configuration 
tab, and in the fields that display below the Domain Name heading, click the 
<Your_Domain_Name> link for the Database Schema (that is, TC_0002, TC_0003, and 
so on) that requires the Costpoint connection pool. 

Where: 

 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0002, TC_0003, or TC_0004, and so on database schema when you originally 
installed the Deltek Time & Expense with Employee Self-Service 9.0.1 software. 

6. When the Database Login screen displays, perform the following: 

http://java.com/
http://10.2.2.54:7001/console
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 Database Login ID — Accept the default of sa. 

 Database Password — Enter the Microsoft SQL Server sa user’s password. 

 Click Ok. 

7. When the Domain <Your_Domain_Name> screen displays, click the Create Costpoint 
Connection link. 

8. When the Create Connection <Your_Domain_Name> screen displays, perform the 
following: 

 Database Platform — Select Sql Server from the drop-down list. 

 IP Address or Hostname — Enter the IP address (that is, 10.2.2.154) or hostname 
(that is, dbsvr01) of your Costpoint database server. The Deltek Time & Expense with 
Employee Self-Service 9.0.1 software uses this information to communicate with your 
Costpoint database server. 

 Port — Enter the port that your Costpoint database server software uses to listen for 
requests. The default port for Microsoft SQL Server is 1433. 

 SQL Server Database Name — Enter the name of your Costpoint Microsoft SQL 
Server database. The default was DELTEKCP. 

 User ID — Enter DELTEK. 

 Password — Enter the password for you DELTEK user. The default was install. 

9. Click OK to create the Costpoint connection pool. 

 

It can take some time to create the Costpoint connection pool. 

Upon successful completion, you will receive the following message: 

Process Completed Successfully! 

If you receive an error code instead of the above message, please contact Deltek 
Technical Support: 

10. When the “Process Completed Successfully!” message displays, click the Application 
Configuration Home link that displays near the bottom of the screen. Verify that Yes 
now displays under the CP Connection heading for the domain you selected. 

 

You must repeat items 4 through 9 of this step for all of your remaining Company 
Domains (that is, schemas TC_0003, TC_0004, TC_0005, and so on) that need a 
Costpoint connection pool. 

11. After Costpoint connection pools have been created for all necessary domains, please 
close the Web browser screen. 

 

For further assistance on configuring Deltek Employee Self-Service 9.0.1, refer to the 
DeltekTimeAndExpense83GettingStartedGuideEmployeeSelfService.pdf file referenced in 
Appendix A: Documentation.  
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Appendix G: Implementing Secure Sockets Layer 
(SSL) Encryption with Deltek Time & Expense with 
Employee Self-Service 9.0.1 
This appendix discusses Time & Expense’s support for SSL encryption and the different 
WebLogic licenses that are available for implementing SSL. It also provides references to 
informational resources that you can use to learn more about implementing SSL with Deltek Time 
& Expense with Employee Self-Service 9.0.1. Finally, it provides directions for changing the 
WebLogic license that is included with the standard distribution of Deltek Time & Expense with 
Employee Self-Service 9.0.1. 

Time & Expense’s Support for SSL 
Deltek Time & Expense with Employee Self-Service 9.0.1 was tested against and supports SSL 
implemented on its WebLogic server and Microsoft Internet Information Server (IIS) components. 

 

The IIS component is optional in the Time & Expense environment. If you have chosen to deploy 
IIS with your Time & Expense environment, you can implement SSL on both your IIS and 
WebLogic server components. 

SSL requirements vary from customer to customer. Consequently, this appendix does not provide 
specific instructions for implementing SSL on either your WebLogic server or IIS components. 
Instead, this appendix provides third-party informational resources that you can use to learn 
about and implement SSL with your Deltek Time & Expense with Employee Self-Service 9.0.1 
environment. 

WebLogic Licenses Available with Deltek Time & Expense with 
Employee Self-Service 9.0.1 
Deltek Time & Expense with Employee Self-Service 9.0.1 supports both of the license types, 
exportable- and domestic-strength, that Oracle’s WebLogic server includes. A brief description of 
each license type follows: 

 Exportable SSL supports 512-bit certificates and 40- and 50-bit bulk data encryption. 

 Domestic SSL also supports 512-bit, 768-bit, and 1024-bit certificates as well as 128-bit 
bulk data encryption. 

The standard Deltek Time & Expense with Employee Self-Service 9.0.1 distribution ships with 
WebLogic’s domestic-strength license already configured. 

 

Only the license is configured. By default, SSL is neither enabled nor operational in the standard 
Deltek Time & Expense with Employee Self-Service 9.0.1 distribution. If you want to implement 
SSL on your WebLogic server, you will need to consult the WebLogic server documentation for 
instructions (see the Informational Resources for Implementing SSL section that displays later in 
this appendix). 
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Deltek recommends using WebLogic’s domestic-strength license because it allows stronger 
encryption for your SSL implementation. However, please note that the United States 
Government does restrict the use of domestic-strength encryption in some countries. 
Consequently, you must consult with your organization’s legal counsel before implementing SSL 
on your WebLogic server to determine which WebLogic license strength (domestic or 
exportable) you must use. The “Changing Your WebLogic Server’s License Strength” section of 
this appendix provides instructions for switching from the domestic-strength license to the 
exportable-strength license. 

Informational Resources for Implementing SSL 
You may implement SSL on either or both of your Deltek Time & Expense with Employee Self-
Service 9.0.1 system’s IIS and WebLogic Server components. For help on implementing SSL, 
please refer to the following URLs: 

WebLogic Server 
 http://e-docs.bea.com/wls/docs92/security.html — WebLogic Server documentation on 

security. 

 http://download.oracle.com/docs/cd/E12840_01/wls/docs103/secmanage/ssl.html — 
WebLogic Server documentation that provides step-by-step instructions for implementing 
SSL on your WebLogic Server. 

IIS 
 http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8

-deed-4056-9592-e721a4889a71.mspx — Microsoft TechNet article that provides an 
overview of using encryption with IIS and specific instructions for configuring SSL. 

In addition to consulting these informational resources, you can contact Deltek’s Systems 
Solutions team to arrange assistance for implementing SSL with your Deltek Time & Expense 
with Employee Self-Service 9.0.1 system. 

Step 1: Stopping Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for stopping the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. 

Where 
This step must be performed from a machine that has Web browser client access via TCP/IP to 
the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com.  

http://e-docs.bea.com/wls/docs92/security.html
http://e-docs.bea.com/wls/docs92/secmanage/ssl.html
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx
http://java.com/
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To stop your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
from a Web browser, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server;. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009 (that is, 
http://10.2.2.54:7009/console). 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

3. Click Login. 

4. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It can take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (that is, http://10.2.2.154) to your Internet 
browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the note on 
the previous page for instructions on downloading and installing it. 

5. When the Settings for DeltekTE screen displays, click the Control tab, and perform the 
following: 

 DeltekTEServer (admin) — Select the check box that displays to the left. 

6. Click Shutdown, and select Force Shutdown Now. 

7. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

8. Close the Web browser screen. 

 

It can take several minutes for your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server to process the shutdown request. 

The shutdown request has completed if either of the following conditions on your 
WebLogic application server is true: 

 The Windows Command Prompt that was used to launch your Deltek Time & 
Expense with Employee Self-Service 9.0.1 WebLogic Server has terminated. 

 The status of the Deltek Time & Expense with Employee Self-Service 9.0.1 
Windows service that was used to start your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic Server has changed from Started to 
blank. 
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Step 2: Changing WebLogic Server’s License Strength 

Purpose 
This step provides instructions for changing your WebLogic Server’s license strength from 
domestic to exportable. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To change your WebLogic Server’s license strength, complete the following steps: 

1. Make a backup of the C:\Oracle\Middleware\license.bea file. 

2. Make a backup of the C:\Oracle\Middleware\weblogic92\server\lib\weblogic.jar file. 

3. Contact Deltek Technical Support for the exportable-strength license files. 

4. After Deltek Technical Support sends you the files, complete the following: 

 Copy the new license.bea file to your C:\Oracle\Middleware\ folder, replacing the 
existing license.bea file. 

 Ccopy the new weblogic.jar file to your 
C:\Oracle\Middleware\weblogic92\server\lib\ folder, replacing the existing 
weblogic.jar file. 

Step 3: Restarting Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server as a Service 

Purpose 
If you have previously configured your Deltek Time & Expense with Employee Self-Service 9.0.1 
application to run as a Windows service, you will need to follow the instructions in this step to 
restart the Deltek Time & Expense with Employee Self-Service 9.0.1 Windows service. 

 

You can skip this step if you have not configured Deltek Time & Expense with Employee Self-
Service 9.0.1 to run as a Windows service. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To restart the Deltek Time & Expense with Employee Self-Service 9.0.1 Windows service, 
complete the following steps: 

1. Click Start » Programs » Administrative Tools » Services. 

2. When the Services window displays, scroll down the Services list, right-click the Time & 
Expense with ESS 9.0.1 service, and click Properties on the shortcut menu. 

3. When the Time & Expense with ESS 9.0.1 Properties screen displays, click the General 
tab. 
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4. Click Start to start the Time & Expense with ESS 9.0.1 service. 

 

The service will indicate that it started immediately. Please note, however, that it will 
take several minutes for the Time & Expense with ESS 9.0.1 service to fully initialize. 
After starting the service, you must wait several minutes before attempting to connect to 
the software. If you encounter problems with the Time & Expense with ESS 9.0.1 
service, check the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file, and report any errors to Deltek Technical Support. 

5. Click OK to close the Time & Expense with ESS 9.0.1 Properties screen. 

6. Close the Services window. 

Step 4: Restarting Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for restarting the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. 

 

You can skip this step if you have configured Deltek Time & Expense with Employee Self-
Service 9.0.1 to run as a Windows service and restarted it in the previous step. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To restart the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server, 
complete the following steps: 

1. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. This will display a Windows Command Prompt window 
and launch a command script that starts the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. As the script executes, you will see a series of messages 
scrolling down the screen. 

 

It will take several minutes for the Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server to start. 

2. If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server starts 
successfully, the following message will display near the bottom of the command line 
shell window: 

<The server started in RUNNING mode. > 
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If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server encounters 
errors during the startup process, the <The server started in RUNNING mode.> message will not 
display and the Windows Command Prompt window may terminate. 

If you do not receive the <The server started in RUNNING mode.> message or the Windows 
Command Prompt window terminates, you must do the following tasks: 

 Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file. 

 Contact Deltek Time & Expense Technical Support. 

Step 5: Logging into your Deltek Time & Expense with Employee 
Self-Service 9.0.1 Company Schema 

Purpose 
This step provides instructions for logging into the Deltek Time & Expense with Employee Self-
Service 9.0.1 system. 

Where 
This step can be performed from any Windows browser client that has TCP/IP access to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. This 
computer must be using a browser client supported by the Deltek Time & Expense with Employee 
Self-Service 9.0.1 release (see the “System Requirements” section for a list of supported browser 
clients for Windows). 

To log in to your Deltek Time & Expense with Employee Self-Service 9.0.1 company 
domain, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009 (that is, 
http://10.2.2.154:7009/DeltekTC/welcome.msv). 

2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter a user ID that exists in your Time & Expense company domain. 

 

The Login ID is case-sensitive. 

 Password — Enter the password for the user. 

 Domain — Enter <Your_Domain_Name>. 
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Where: 

 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0002 database schema when you originally installed the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software. 

 Language — Select your language from the drop-down box (for example, 
English/United States). 

3. Click Login. 

4. When the Welcome screen displays, you can begin using the Deltek Time & Expense 
with Employee Self-Service 9.0.1 system. 

 

Please contact Deltek Time & Expense Technical support if you have any problems logging into 
the application. 
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Appendix H: Lightweight Directory Access 
Protocol (LDAP) 
Deltek Time & Expense with Employee Self-Service supports Lightweight Directory Access 
Protocol (LDAP), a protocol used to access "Directory Servers." The Directory is a special 
database that holds information in a tree structure.  

LDAP authentication is enabled through tight integration with the industry-strength security 
framework of the WebLogic Server. When you log in, WebLogic coordinates and executes user 
authentication using its security configuration. If the system is set up to use LDAP, it 
authenticates with the LDAP server on behalf of the Deltek Time & Expense with Employee Self-
Service application. No custom code is involved in this process. 

When you log in to Deltek Time & Expense with Employee Self-Service, the password is 
authenticated against either a LDAP directory or the Deltek Time & Expense with Employee Self-
Service database tables, depending on whether you integrated Time\Expense\Self-Service with 
Microsoft's Active Directory LDAP Server during the installation phase. The other areas in the 
system that use and/or are affected by LDAP are outlined in the following sections. For complete 
instructions on how to set up Deltek Time & Expense with Employee Self-Service for LDAP, see 
the installation instructions. 

Setting Up WebLogic to Work with LDAP 

To set up WebLogic to work with LDAP, complete the following steps: 

1. Log in to the WebLogic console. 

2. Click Lock & Edit. 

3. Click Security Realms in the Domain Structure tree to display the list of realms. 

4. Click the TERealm link to display realm information. 

5. Click the Providers tab. The tab lists configured Authentication providers. 

6. Click New. 

7. Enter any name (for example: AD), and select TCADAuthenticator from the Type drop-
down list. 

8. Click Ok. 

9. On the Providers tab, click the new provider. 

10. Change the Control Flag to SUFFICIENT. 

11. Click the Provider specific link at the top of the provider information. 

12. Enter the values into the fields. 

 Domain — Enter the name of Active Directory domain. 

 Host — Enter the host name or IP Address of your Active Directory server. 

13. Click Save. 

14. Click Activate changes. 
15. Restart WebLogic. 
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Technical Console 
To get to the Technical Console, log in to the WebLogic console application, and click 
Application Configuration in the Domain Structure portlet on the left. 

In the Technical Console, where you create or edit Deltek Time & Expense with Employee Self-
Service domains, select LDAP from the Authentication Method drop-down list to indicate that 
LDAP is used for a specific domain. If your user IDs in LDAP directory match the Login ID field 
values in the Employee Information screen, select LOGIN_ID from the Login ID Source drop-
down list. If your user IDs are longer than 20 characters and are stored in the LDAP ID field on 
the Employee Information screen, select CONTEXT_ID from the Login ID Source drop-down list. 

Employee Information 
Specify the valid LDAP IDs in the LDAP ID field on the Basic Information tab of the Employee 
Information screen. In order for Deltek Time & Expense with Employee Self-Service to work with 
your LDAP authentication provider, your Deltek Time & Expense with Employee Self-Service 
LDAP ID must exactly match the corresponding user ID in your LDAP directory.  

If you do not supply a LDAP ID in the Employee Information screen and you try to log into the 
system, it will check for a matching Login ID instead.  

Note that you have to supply the LDAP ID if your 
TC_0000.SCHEMA_CONFIG.S_AUTHENTICATION_SOURCE_CD = ‘CONTEXT_ID’ (Login ID 
Source is “CONTEXT_ID” in the Technical Console) 

The Reset Password button on the Basic Information tab will be disabled when you use LDAP 
authentication.  

Login 
If you use LDAP for your password authentication, the system first tries to validate your LDAP ID 
in the Employee Information screen against the LDAP directory. If it matches, you can log in. If it 
does not match, the system displays the following message: "Invalid Login Attempt." 

If you do not have a LDAP ID set up in the system, the system tries to validate your Login ID 
against the LDAP directory. If it matches, you can log in. After you log in, the system finds your 
employee record based on Login ID. If it does not match, the system displays the following 
message: "Invalid Login Attempt." 

The behavior described above is valid when 
TC_0000.SCHEMA_CONFIG.S_AUTHENTICATION_SOURCE_CD = ‘LOGIN_ID’. 

If your TC_0000.SCHEMA_CONFIG.S_AUTHENTICATION_SOURCE_CD = ‘CONTEXT_ID’, 
you have to select LDAP ID on the Employee Information screen for each employee, and you 
have to enter it on the login screen to be able to log in. The system uses the value of LDAP ID to 
authenticate against the LDAP directory and then finds your employee record based on it. 

If you select the Change Password option on the Login screen, the system displays the following 
message after a successful login: "Please note that your password cannot be changed here 
because your system is using LDAP authentication." 

Timesheet Signature 
When you enter your password during the timesheet signature process and click OK, the system 
validates your password against the password you entered when logging into the system. If it 
does not match, the system displays the following error message: "Invalid Password." 
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Timesheet Approval 
If you require your supervisors to enter a password when approving their employee timesheets, 
the system validates the password against the password they entered when logging into the 
system. If it does not match, the system displays the following error message: "Invalid Password." 

Password Utility 
The Reset Password option is not available as an Action on the Password Utility screen if you 
use LDAP to authenticate your passwords. 

Expense Report Signature 
When you enter your password during the expense report signature process and click OK, the 
system validates your password against the password you entered when logging into the system. 
If it does not match, the system displays the following error message: "Invalid Password." 

Expense Report Approval 
If you require your supervisors to enter a password when approving their employee expense 
reports, the system validates the password against the password they entered when logging into 
the system. If it does not match, the system displays the following error message: "Invalid 
Password." 
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Appendix I: Single Sign-On 

 

Single Sign On (SSO) Functionality is a feature that you can choose to install with your Deltek 
T&E instance. This functionality relies on third party applications (for example, Microsoft IIS & 
ISA, or BEA Weblogic) to allow users to pass the necessary information through the 
infrastructure to facilitate the SSO capability. This is not a feature that Deltek installs with the 
core application.  

Depending on the characteristics and complexities of the environment that supports your Deltek 
applications, this functionality can be challenging to install and might take hours or days to 
complete. Deltek Technical Consulting Services can assist you in managing a multi-vendor team 
that may be required to achieve a successful installation. 

If you experience difficulties implementing this functionality, contact Deltek Customer Care. They 
will put you in contact with a Deltek Consulting Manager, who will outline your options and help 
you engage a qualified technical consultant to work with your internal IT organization. 

This appendix includes the steps needed to implement Single Sign-On with Windows 
Authentication on Deltek Time & Expense with Self-Service. Also included in this appendix is 
information on using this solution with Windows Network Load Balancing (NLB), ideas on 
troubleshooting problems, and some general considerations.  

To use Single Sign-On with the Windows 2008 R2 platform, the following requirements must be in 
place: 

 AES-128, AES-256, and RC4 supported Kerberos encryption for WebLogicServer Active 
Directory user account 

 Internet Explorer 8.0 and later for client workstations 

Setting up Single Sign-On is a three-step process: 

1. Configure the Active Directory Server. 

2. Configure the WebLogic Server. 

3. Configure IE browsers to work with this configuration. 

 

In the sample procedure below, the following names are used: 

 WebLogic Server Active Directory user account —sso_weblogic 

 Active Directory Domain name — esdtest1.com 

 WebLogic  Server host name — serv2 

Configure the Active Directory Server 
The first step to implementing Single Sign-On with Windows Authentication is to configure the 
active directory server, which has two steps: 

 Create a new user account in Active Directory. 

 Use setspn to create the Service Principal Name (SPN). 

Create a New User Account in Active Directory 

To create a new user account in Active Directory for the host computer on which 
WebLogic Server runs, complete the following steps: 

1. Start the Active Directory Users and Computers program on the Active Directory server. 
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2. Click New User. 

3. Name the new user account. 

4. Under Account Options, select the This account supports Kerberos AES 128 bit 
encryption option. 

 

Enabling AES encryption can corrupt the user’s password. Reset the password after 
this step. 

5. Under Account Options, clear the Do not require Kerberos preauthentication option. 
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Use setspn to Create the Service Principal Name (SPN) 
Use the setspn utility to create the Service Principal Name (SPN) for the user account created in 
the previous steps. You use SPNs to locate a target principal name for running a service. setspn 
allows you to view the current SPNs, reset the account's default SPNs, and add or delete 
supplemental SPNs. Some services and applications may require manual modification of a 
service account's SPN information to authenticate correctly.  

 

For more information about setspn.exe, refer to the following Webpage: 

http://technet.microsoft.com/en-us/library/cc731241(v=ws.10).aspx 

To use the setspn utility to create the Service Principal Name (SPN) for the user account, 
complete the following steps: 

1. Locate and execute the setspn utility in the Windows 2008 Resource Kit. 

2. Enter the following commands at the DOS prompt:  
setspn -a HTTP/serv2.ESDTEST1.COM sso_weblogic 

Where 

serv2 is the server machine name running WebLogic. 

 

The domain name (ESDTEST1.COM) in the WebLogic Server host name must be 
UPPERCASE. 

The following output displays: 
Registering ServicePrincipalNames for 
CN=sso_weblogic,CN=Users,DC=esdtest1,DC=com 

HTTP/serv2.ESDTEST1.COM 
Updated object 

3. Use the following command to identifythe SPNs associated with your user account: 

setspn -L sso_weblogic 

The following output displays: 
Registered ServicePrincipalNames for 
CN=sso_weblogic,CN=Users,DC=esdtest1,DC=com 

HTTP/serv2.ESDTEST1.COM 

 

This step is critical. If the same service is linked to a different account in the Active 
Directory server, the client does not send a Kerberos ticket to the server. 

Configure WebLogic Server 
The second step to implementing Single Sign-On with Windows Authentication is to configure the 
WebLogic server, which entails: 

 Creating the Keytab file with ktab.exe 

 Processing the Keytab file with kinit.exe 

 Configuring WebLogic to use Negotiate Identity Asserter 

http://technet.microsoft.com/en-us/library/cc731241(v=ws.10).aspx
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 Creating a JAAS login file for WebLogic to connect with Kerberos 

 Modifying the Time & Expense with ESS startup command 

 Setting SCHEMA_CONFIG.S_AUTHENTICATION_CD to SSO 

Create the Keytab file with ktab.exe 

Prior to creating the keytab file, complete the following steps: 

1. Create a file named krb5.ini in your C:\Windows directory. (Use the WordPad text editor 
to create the file.) 

 

The Windows environment variable PATH must contain the folder C:\WINDOWS. 

2. Add the following parameters to the krb5.ini file: 
[libdefaults] 

default_tkt_enctypes = aes128-cts rc4-hmac 

default_tgs_enctypes = aes128-cts rc4-hmac 

ticket_lifetime = 600 

 

[appdefaults] 

autologin = true 

forward = true 

forwardable = true 

encrypt = true 

To create the keytab file, complete the following steps: 

1. At the DOS command prompt, enter the following command to process your keytab file: 
C:\Oracle\Middleware\jdk1.7.0_02\bin\ktab -k 
C:\Oracle\Middleware\DeltekTE90\te_sso_keytab –a 
sso_weblogic@ESDTEST1.COM -n 0 

 

The domain name (ESDTEST1.COM) in the username must be UPPERCASE. 

For the last option -n 0, 0 stands for digit 0.  

Do not use –n 0 option, if you’re running JDK version 1.6 or below. 

You create the te_sso_keytab file in your delteke domain folder (for example, 
C:\Oracle\Middleware\DeltekTE90). 

2. You will be prompted for a password. Enter the password for the sso_weblogic user 
created in Active Directory earlier: 
Password for sso_weblogic@ESDTEST1.COM:Password1 

3. You should see the following output: 
Done! 

Service key for sso_weblogic@ESDTEST1.COM is saved in 
C:\Oracle\Middleware\DeltekTE90\te_sso_keytab 
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Process the keytab File with kinit.exe 
After creating the keytab file, you need to run the kinit utility. You use this utility to obtain and 
cache Kerberos ticket-granting tickets.  

To process the keytab file with kinit, complete the following steps: 

1. Run the kinit.exe utility to process your keytab file: 
C:\Oracle\Middleware\jdk1.7.0_02\bin\kinit -k -t 
C:\Oracle\Middleware\DeltekTE90\te_sso_keytab sso_weblogic@ESDTEST1.COM 

 

The domain name (ESDTEST1.COM) must be UPPERCASE. 

The following output displays: 
New ticket is stored in cache file 
C:\Users\Administrator.ESDTEST1\krb5cc_administrator 

2. Run the klist program to verify that the kinit program succeeded. klist displays the 
entries in the local credentials cache and key table. After you modify the credentials 
cache with kinit or modify the te_sso_keytab with ktab, the only way to verify the 
changes is to view the contents of the credentials cache and/or te_sso_keytab using 
klist. This program does not change the Kerberos database.  

Use this command to run the klist program: 
C:\Oracle\Middleware\jdk1.7.0_02\bin\klist 

The following output displays: 
Credentials cache: 
C:\Users\Administrator.ESDTEST1\krb5cc_administrator 

 

Default principal: sso_weblogic@ESDTEST1.COM, 1 entry found. 

 

[1]  Service Principal:  krbtgt/ESDTEST1.COM@ESDTEST1.COM 

     Valid starting:  Feb 09, 2012 13:28 

     Expires:         Feb 09, 2012 23:28 

Configure WebLogic to use Negotiate Identity Asserter 
1. Login to the WebLogic console. 

2. In the top left corner of the screen, click Lock & Edit. 

3. In the Domain Structure portlet, click Securityrealms. 

4. Click TERealm. 

5. In the Settings for TERealm window, click the Providers tab. The Authentication tab 
displays.  

6. Click New, and enter any name (for example, TENegotiateIdentityAsserter). 

7. From the list of available authentication providers, select Negotiate Identity Asserter. 

8. Click OK. 
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9. Click Reorder to ensure that the new Negotiate Identity Asserter provider comes first in 

the list of authenticators. 

10. In the top-left corner, click Activate changes. 

11. Restart the WebLogic server for this change to take effect. 

 

Ensure that the TCADAuthenticator provider exists in the list of providers. 

Create a JAAS Login File for WebLogic to Connect with Kerberos 
The JAAS login file tells the WebLogic security framework to use Kerberos authentication and 
defines the location of the keytab file that contains the Kerberos identification information for the 
WebLogic server. 

To create a JAAS login file, complete the following steps: 

1. Use any text editor to create a JAAS login file with the name krb5login.conf. 

2. Add the following contents to the file: 

com.sun.security.jgss.krb5.accept { 

 com.sun.security.auth.module.Krb5LoginModule required 

 principal="sso_weblogic@ESDTEST1.COM" useKeyTab=true  

 keyTab="C:\\Oracle\\Middleware\\DeltekTE90\\te_sso_keytab" 
isInitiator=false storeKey=true; 

}; 
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3. Copy the file into the \Oracle\middleware\DeltekTE90 or equivalent folder.  

Modify the Time & Expense with ESS Startup Command 
You must modify the Java command that starts WebLogic, either in the startupDeltekTE.cmd file 
or the file that is called when WebLogic is set up as a service.  

To modify the Time & Expense with ESS Startup Command, complete the following step: 

1. Add the following command line parameters into the WebLogic start command: 

-Djava.security.auth.login.config=krb5login.conf  

-Djavax.security.auth.useSubjectCredsOnly=false  

-Dweblogic.security.enableNegotiate=true  

Here is an example command with those parameters added. The new commands display in 
boldface: 

"%JAVA_HOME%\bin\java" %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% -
Dweblogic.Name=%SERVER_NAME% - 
Djava.security.auth.login.config=krb5login.conf -
Djavax.security.auth.useSubjectCredsOnly=false -
Dweblogic.security.enableNegotiate=true -
DjmsHost=t3://%JMS_HOST_ADDR% -
Dhibernate.cglib.use_reflection_optimizer=false weblogic.Server 

Set SCHEMA_CONFIG.S_AUTHENTICATION_CD to SSO 
The TC_0000.SCHEMA_CONFIG column in the database table must be set to indicate which of 
the existing domains to use for single sign on. In the current implementation of this authentication 
solution, only one domain may participate in the single sign on system. For that schema, the 
value of the S_AUTHENTICATION_CD column must be set to the value of SSO. Only one 
domain may have this value in that column. The default value for this column is DATABASE. 

If the network user names match the values in the TC_0000.USER_INFO.LOGIN_ID field,the 
S_AUTHENTICATION_SOURCE_CD needs to contain the default value of LOGIN_ID. If the 
network user names are longer than 20 characters, then all the network names need to be stored 
in the TC_0000.USER_INFO.LDAP_CONTEXT_S column, and the value of the 
S_AUTHENTICATION_SOURCE_CD field needs to be CONTEXT_ID. 
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Configure IE Browsers to Work with This Configuration 

 

The information in this section is from the WebLogic documentation 
athttp://docs.oracle.com/cd/E24329_01/web.1211/e24422/sso.htm. 

Complete the following procedures to configure your Internet Explorer (IE) browser to use 
Windows authentication. 

To configure local intranet domains, complete the following steps: 

1. In Internet Explorer, click Tools » Internet Options.  

2. Click the Security tab. 

3. Select Local intranet, and click Sites. 

4. On the Local intranet dialog box, ensure that the Include all local (intranet) sites not 
listed in other zones and Include all sites that bypass the proxy server options are 
selected. 

5. Click Advanced. 

6. In the Local intranet (Advanced) dialog box, add all relative domain names that will be 
used for WebLogic Server instances participating in the SSO configuration (for example, 
myhost.example.com), and click Close.  

To configure intranet authentication, complete the following steps: 

1. In Internet Explorer, click Tools » Internet Options. 

2. Click the Security tab. 

3. Select Local intranet, and click Custom Level. 

4. On the Security Settings dialog box, scroll to the User Authentication section.  

5. Select Automatic logon only in Intranet zone. This option prevents users from having 
to re-enter logon credentials, which is a key piece to this solution. 

6. Click OK.  

To verify the proxy settingsif you have a proxy server enabled, complete the following 
steps: 

1. In Internet Explorer, click Tools » Internet Options. 

2. Click the Connections tab. 

3. Click LAN Settings. 

4. On the Local Area Network (LAN) Settings dialog box, verify that the proxy server 
address and port number are correct. 

5. Click Advanced.  

6. On the Proxy Settings dialog box, ensure that all desired domain names are entered in 
the Exceptions field. 

7. Click OK to close the Proxy Settings dialog box.  

To set integrated authentication for Internet Explorer 6.0, complete the following steps: 

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/secmanage/sso.html
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In addition to the previous settings, you require one additional setting if you use Internet 
Explorer 6.0.  

1. In Internet Explorer, click Tools » Internet Options. 

2. Click the Advanced tab. 

3. Scroll to the Security section.  

4. Ensure that Enable Integrated Windows Authentication option is selected, and click 
OK. 

5. If you had to select this option, restart the browser. 

Using Windows Network Load Balancing with AD/Kerberos SSO 
Using Windows Network Load Balancing (NLB) requires changing a few steps in the process 
described above. This change treats the virtual host or cluster that you create when configuring 
NLB as though it was a single machine. NLB does create a single service; although, it is 
implemented through multiple back-end servers.  

The first step is to register the cluster name as a host or computer in Active Directory. Then follow 
the procedure to create a new user account in Active Directory and create one for the cluster.  

 

The clusters machine name and this new user account must be different, just as when working 
with single machines. 

After creating the new user account in Active Directory for the cluster, follow the procedure to run 
setSpn.exe to create the SPN. 

The next step is to generate a keytab file as described above. Follow the same procedure shown, 
but use the cluster machine account name and the cluster user account name in place of the 
server names.  

Copy the keytab file to all the back-end servers that participate in the NLB cluster, and run the 
kinit.exe and klist.exe programs exactly as shown above for a single server. Use the cluster 
name, not the stand-alone server name, when running kinit.exe, even though you are running it 
on a server with a different machine name.  

All other procedures for WebLogic configuration and browser configuration remain the same.  

Error Messages and Possible Causes 
You may encounter the following error message while running KINIT.EXE: 

“Preauthentication failed while getting initial credentials.” 

Possible causes for this error include: 

 System clock error > 5 minutes 

 Wrong password 

 User does not have an account in the host's realm 

 Realm mismatch 
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Troubleshooting 
When diagnosing problems with Time & Expense with ESS Windows SSO, there are three main 
procedures to help you with troubleshooting. These are: 

 Turning on verbose logging during authentication attempts 

 Increasing the logging output by Time & Expense with ESS 

 Using an additional run-time command line switch 

These procedures are detailed below.  

Verbose Logging 
It is helpful to have verbose logging turned on during SSO authentication attempts. 

To turn on verbose logging, complete the following steps: 

1. In the WebLogic console, click Lock & Edit in the top left corner. 

2. In the Domain Structure on the left, click Environment – Servers. 

3. On the Summary of Servers page, click DeltekTEServer(admin). 

4. Click the Debug tab. 

5. Drill down to weblogic – security – atn. 

6. Select the DebugSecurityAtn option. 

7. Click Enable at the top or bottom of the page. 

8. Click on Logging tab 

9. Click on Advanced link at the bottom 

10. In Message Destination(s) -  Log File section select Severity Level = Debug 

11. Click Save at the top or bottom of the page 

12. Click Activate changes in the top-left corner. 

 

You do not need to restart the WebLogic server for this change to take effect. 

Increase Logging 
You can also increase Time & Expense with ESS’s logging output with respect to DATABASE 
and LDAP authentication. 

To increase the logging output, complete the following steps: 

1. Login to the WebLogic console. 

2. In the Domain Structure portlet, click Domains 

3. Click the Logging tab. 

4. Click Add Category. 

5. For Category, enter com.deltek.tc.security.providers.authentication. 

6. Set the Log Level to debug. 
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7. Click Apply. 

 

This high level of verbose logging can impose a performance penalty on the operation of your 
production system. After you have solved your authentication problems, Deltek recommends 
that you restore the settings in these files to settings that allow for adequate server performance. 

Add Run-Time Command Line Switch 
There is an additional run-time command line switch that you can use when diagnosing SSO 
problems. Add the following to the command line switches to cause a display of additional log 
messages about the operation of AD/Kerberos SSO.  

To add an additional run-time command line switch, complete the following steps: 

1. Access the startup file. 

2. Locate the following command: 

-Djava.security.auth.login.config=krb5login.conf 

3. Add the following command just before the command in step 2: 

-Dsun.security.krb5.debug=true 

 

For more information of many Kerberos errors and their possible causes, refer to the following 
Webpage: 

http://www.microsoft.com/technet/prodtechnol/windowsserver2003/technologies/security/tkerberr
.mspx 

Running Time & Expense with ESS with Windows SSO 

Different URL for SSO login 
Beginning with Deltek Time and Expense with Employee Self-Service v 8.1, the URL for SSO 
login is http://myhost.example.com/DeltekTC/sso.msv. 

The regular login page URL http://myhost.example.com/DeltekTC/welcome.msv can be used for 
non-SSO login by users who are not members of the Windows domain. 

There are two areas where running SSO changes the operation of Time & Expense with ESS. 
The first is the log out operation, and the second is the timesheet or expense sign and approval 
operation. There are also several conditions that must be true for the solution to work. First, a 
user who intends to access Time & Expense with ESS through this SSO solution must 
authenticate to the same Active Directory domain controller that holds the WebLogic application 
server user account. Second, the same user identifier must also be put into the LOGIN_ID fields 
of the EMPL and USER_INFO tables or in LDAP_CONTEXT_S field of USER_INFO table. 

Logging Out of Time & Expense with ESS after Logging in Automatically 
Time & Expense with ESS’s current design is to return to the normal login ID/password entry 
login screen when the user logs out of the system. This enables logging into Time & Expense 
with ESS as a different user than the user logged onto the Windows client machine. This may be 
valuable for administration, support, maintenance, or other non-standard use. However, this may 
not be what you want. It may also be possible to modify the mustang-transitions.xml file to 
redirect the user to any other desired web page upon logging out. Please contact Deltek support 
for help with this.  

http://www.microsoft.com/technet/prodtechnol/windowsserver2003/technologies/security/tkerberr.mspx
http://www.microsoft.com/technet/prodtechnol/windowsserver2003/technologies/security/tkerberr.mspx
http://myhost.example.com/DeltekTC/sso.msv
http://myhost.example.com/DeltekTC/welcome.msv
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Timesheet/Expense Signing or Approval 
If your system is set up to have timesheet, expense report, or expense authorization signing or 
approving, Time & Expense with ESS normally requires that the signing or approving user enter a 
password, even if you use SSO. If you do not want users to have to enter a password in these 
cases, go to the Time and Expense configuration screens and remove all of the signature and/or 
approval text specified there. If there is no text specified for an action, Time & Expense with ESS 
does not require a password; if there is text, it does require a password. 

The User Must Authenticate to an Active Directory Domain 
A user logging into Time & Expense with ESS using Windows SSO must log into the machine he 
will be using and be authenticated to the same Active Directory domain on which the server 
running Time & Expense with ESS has a user account as shown earlier in this document. It is 
those credentials that will be passed by Internet Explorer to Time & Expense with ESS.  

When testing, keep in mind that if you run your Internet Explorer on the same machine as the 
WebLogic server, SSO will not work. 

The User Identifier Used in Active Directory Must Also Be in Time & 
Expense with ESS 
The same user identifier string used as the login id of the user when he or she logs into the Active 
Directory controller must also be used to populate the TC_0000.USER_INFO.LOGIN_ID, 
TC_0000.USER_PASSWORD.LOGIN_ID, and TC_0001.EMPL.LOGIN_EMPL_ID fields.  

 

These three fields each have a length of 20 characters. If that is not enough, all network names 
must be stored in TC_0000.USER_INFO.LDAP_CONTEXT_S, and the 
TC_0000.SCHEMA_CONFIG.S_AUTHENTICATION_SOURCE_CD field value must be 
changed from LOGIN_ID to CONTEXT_ID.  

This is how the connection is made between the user identifier used to authenticate to Active 
Directory and the employee ID in Time & Expense with ESS. During authentication, Time & 
Expense with ESS checks to see if an employee with that login ID exits in the database. This can 
be accomplished for each user by changing the login ID or LDAP ID in the Time & Expense with 
ESS employee information screen. 

 

See the WebLogic documentation page on this topic: 

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/secmanage/sso.html 

Microsoft has documentation on this technology in a three part article titled 

"HTTP-Based Cross-Platform Authentication via the Negotiate Protocol." 

 Part I: Network Infrastructure:  

http://msdn2.microsoft.com/en-us/library/ms995329.aspx 

 Part II: SPNEGO Tokens and the Negotiate Protocol 

http://msdn2.microsoft.com/en-us/library/ms995330.aspx 

 Part III: SPNEGO Token Handler API 

http://msdn2.microsoft.com/en-us/library/ms995331.aspx 

http://download.oracle.com/docs/cd/E12840_01/wls/docs103/secmanage/sso.html
http://msdn2.microsoft.com/en-us/library/ms995329.aspx
http://msdn2.microsoft.com/en-us/library/ms995330.aspx
http://msdn2.microsoft.com/en-us/library/ms995331.aspx
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Appendix J: Changing WebLogic System User’s 
Password 

Overview 
This appendix provides instructions for changing the WebLogic system user’s password. The 
Deltek Time & Expense with Employee Self-Service 9.0.1 system was supplied with a default 
WebLogic system user’s password of weblogic. 

1. Changing WebLogic system User’s Password 

Purpose 
This step provides instructions for changing the WebLogic system user’s password. 

Where 
You must perform this step from a machine that has Web browser client access via TCP/IP to the 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 

To change the WebLogic system user’s password, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

Error! Hyperlink reference not valid. 

 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server uses to listen for 
connections. You specified this port value during the Deltek Time & Expense 
with Employee Self-Service 9.0.1 software installation. The default is 7009. 

For example, http://10.2.2.154:7009/console 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
is weblogic. 

 Click Log In. 

3. When the Welcome, system screen displays, in the left pane, under Domain Structure, 
under the DeltekTE node of the hierarchical tree, select Security Realms. 

4. When the Summary of Security Realms screen displays, click the TERealm hypertext link 
in the fields that appear below the Name heading. 

5. When the Settings for TERealm screen displays, click the Users and Groups tab. 

6. When the Users screen displays, click the system hypertext link in the fields that appear 
below the Name heading. 

http://10.2.2.54:7001/console


Appendix J: Changing WebLogic System User’s Password 

 

New Installation for Microsoft SQL Sever 97 

 

7. When the Settings for system screen displays, click the Passwords tab, and perform the 
following: 

 New Password — Enter your new password. 

 

The password is case-sensitive and must be a minimum of 8 characters. 

 Confirm New Password — Re-enter the password. 

 Click Save. 

8. When the “Password has been changed” message displays, click the Continue 
hypertext link. 

9. When the Welcome system screen displays, in the left pane, under Domain Structure, 
under the DeltekTE node of the hierarchical tree. 

10. When the Settings for DeltekTE screen displays, click the Control tab, and complete the 
following step: 

 DeltekTEServer (admin) — Select this option. 

11. Click Shutdown, and select Force Shutdown Now. 

12. When the Server Life Cycle Assistant screen displays, click Yes. 

13. Close the Web browser screen. 

2. Modifying boot.properties File 

Purpose 
This step provides instructions for modifying the boot.properties file so that it reflects the 
WebLogic system user’s new password. 

Where 
You must perform this step on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To modify the WebLogic system user’s password in the boot.properties file, complete the 
following steps: 

1. Make a backup of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\security\boot.properties 
file. 

2. Open the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\security\boot.properties 
file with a text editor (such as Notepad). 

3. Find password= (near the top of the file), and replace the encrypted password (that is, 
{3DES}kG97B7eYRsSZmK8bpYk0qA\=\=) with your new WebLogic system user’s 
password. 

 

The clear text password you enter here will automatically get encrypted when you 
restart your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic 
Server. 
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4. Save the boot.properties file. 

5. Close your text editor. 

3. Restarting Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server as a Service 

Purpose 
If you have previously configured your Deltek Time & Expense with Employee Self-Service 9.0.1 
system to run as a Windows service, you must follow the instructions in this step to restart the 
Deltek Time & Expense with Employee Self-Service 9.0.1 Windows service. 

 

You may skip this step if you have not configured Deltek Time & Expense with Employee Self-
Service 9.0.1 to run as a Windows service. 

Where 
You must perform this step on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To restart the Deltek Time & Expense with Employee Self-Service 9.0.1 Windows service, 
complete the following steps: 

1. Click Start » All Programs » Administrative Tools » Services. 

2. When the Services window opens, scroll down the Services list to find the Time & 
Expense with ESS 9.0.1 service. Right-click on the Time & Expense with ESS 9.0.1 
service and select Properties. 

3. When the Time & Expense with ESS 9.0.1 Properties screen displays, click the General 
tab, and click Start to start the Time & Expense with ESS 9.0.1 service. 

 

The service will indicate that it started immediately. Please note, however, that it will 
take several minutes for the Time & Expense with ESS 9.0.1 service to fully initialize. 

After starting the service, you should wait several minutes before attempting to connect 
to the software. 

If you encounter problems with the Time & Expense with ESS 9.0.1 service, select the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file and report any errors to Deltek Technical Support. 

4. Click OK to close the Time & Expense with ESS 9.0.1 Properties screen. 

5. Close the Services window. 

4. Restarting Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server 

Purpose 
This step provides instructions for restarting the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. 
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You may skip this step if you have configured Deltek Time & Expense with Employee Self-
Service 9.0.1 to run as a Windows service and restarted it in the previous step. 

Where 
You must perform this step on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To start your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server 
from the Windows Start menu, complete the following steps: 

1. Click Start » All Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. This opens a Windows Command Prompt, and 
launches a command script that starts the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. When the Windows Command Prompt window opens, 
you will see a series of messages scrolling down the screen. 

 

It will take several minutes for the Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server to start. 

2. If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server starts 
successfully, the following message displays near the bottom of the command line shell 
window: 

<The server started in RUNNING mode. > 

 

If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server encounters 
errors during the startup process, the <The server started in RUNNING mode.> message will 
NOT display and the command line shell (DOS window) may terminate. 

If you do not receive the <The server started in RUNNING mode.> message or the command 
line shell (DOS window) terminates, you should: 

 Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file. 

 Contact Deltek Technical Support. 
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Appendix K: Migrating Time Collection 4.1 Data to 
Deltek Time & Expense with Employee Self-
Service 9.0.1 
This appendix provides instructions for migrating your Time Collection 4.1 data to your new 
Deltek Time & Expense with Employee Self-Service 9.0.1 database. During the migration 
process, you will execute the following steps: 

1. Prepare the Deltek Time & Expense with Employee Self-Service 9.0.1 migration 
environment. 

2. Back up the Time Collection 4.1 and Deltek Time & Expense with Employee Self-Service 
9.0.1 databases. 

3. Run the Deltek Time & Expense with Employee Self-Service 9.0.1 Data Migration install 
program to create scripts that will be used to perform the migration. 

4. Execute the migration scripts to populate the Deltek Time & Expense with Employee Self-
Service 9.0.1 database with your Time Collection 4.1 data. 

Limitations 
The Time Collection 4.1 to Deltek Time & Expense with Employee Self-Service 9.0.1 data 
migration process has the following limitations: 

 Only Time Collection 4.1 data can be migrated to the Deltek Time & Expense with 
Employee Self-Service 9.0.1 database. If you are currently running the Time Collection 
3.x system or the Time Collection 4.0 system, you must upgrade to Time Collection 4.1 
before you can migrate your data to Deltek Time & Expense with Employee Self-Service 
9.0.1. 

 The migration does NOT support converting Gupta SQLBase databases. If you are using 
SQLBase for your Time Collection 4.1 database, please contact Deltek’s Systems 
Solutions team to discuss your migration options. 

 The Deltek Time & Expense with Employee Self-Service 9.0.1 database’s default sort 
order is case-insensitive. If your Time Collection 4.1 Microsoft SQL Server database’s 
default sort order is also case-insensitive, you may proceed with the data migration 
instructions included in this appendix. However, if your Time Collection 4.1 SQL Server 
database’s default sort order is case-sensitive, its data may not readily migrate to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 database. Case-sensitive Time 
Collection 4.1 database users should contact Deltek Technical Support before 
proceeding with the instructions contained in this appendix. 

 

You can review the default sort order of your Time Collection 4.1 database by executing the 
following statement in SQL Query Analyzer, connected to your Time Collection 4.1 database 
(DELTEKET), as the sa user: 

sp_helpsort 

Prerequisites 
In order to migrate your Time Collection 4.1 data to your new Deltek Time & Expense with 
Employee Self-Service 9.0.1 database, the following prerequisites must be met: 
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 The Deltek Time & Expense with Employee Self-Service 9.0.1 system must be installed 
and configured. 

 Data can only be migrated between databases using the same RDBMS platform (that is, 
Microsoft SQL Server to Microsoft SQL Server). The Deltek Time & Expense with 
Employee Self-Service 9.0.1 Data Migration program does not support migrating data 
between different RDBMS platforms (that is, SQLBase to Microsoft SQL Server or Oracle 
to Microsoft SQL Server). 

 The Time Collection 4.1 database and the new Deltek Time & Expense with Employee 
Self-Service 9.0.1 database must reside on the same Microsoft SQL Server 2000 
database server. 

 The migration must be performed on the Microsoft SQL Server 2000 database server that 
hosts your Time Collection 4.1 and 9.0.1 databases or a Windows client workstation that 
has osql connectivity to the database server. 

 The migration must be performed with the Microsoft SQL Server 2000 database server’s 
sa user account. 

 The various data migration options (listed in Step 6, items 7, 8, 9, and 10 of this 
appendix) should be thoroughly reviewed before beginning the migration. 

Step 1: Configuring Deltek Time & Expense with Employee Self-
Service 9.0.1 Environment 

Purpose 
This step provides instructions for preparing your Deltek Time & Expense with Employee Self-
Service 9.0.1 environment for the data migration. 

Where 
This step may be performed from any supported browser client that has TCP/IP access to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. This 
computer must be using a browser client supported by the Deltek Time & Expense with Employee 
Self-Service 9.0.1 release. 

 

See the “System Requirements” section for a list of supported browser clients. 

To prepare your Deltek Time & Expense with Employee Self-Service 9.0.1 database for the 
data migration, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009 (that is, 
http://10.2.2.154:7009/DeltekTC/welcome.msv). 

http://10.2.2.154:7009/DeltekTC/welcome.msv
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2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter install. 

 

The Login ID is case-sensitive and MUST be entered in lowercase. 

 Password — Enter password. 

 

The password is case-sensitive and MUST be entered in lowercase. 

 Domain. Enter <Your_Domain_Name>. 

Where: 

 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_000x database schema when you created your company domain. 

 Language — Select your language from the drop-down box (i.e., English/United 
States). 

3. Click Login. 

4. When the Welcome screen displays, click Configuration » General from the Menu 
Navigation Area on the left side of the screen. 

5. When the General Configuration screen displays, click the UDT Options tab and 
configure the UDT options just as you have them set up in your Time Collection 4.1 
system’s Configuration screen. 

 UDT01 … UDT15 — Select which UDT codes to Use, the Order (1-15) to use them, 
their Label, and their Plural Label as well as their Size. 

 Links (UDT01/UDT02, UDT01/UDT07, UDT01/UDT09, UDT02/UDT07, 
UDT02/UDT09, UDT09/UDT03) — Select the method for linking the UDT codes: 
None, Direct, or Wildcard. 

 Enter by Abbreviation (UDT01, UDT02, UDT09, Display Abbreviation in Charge 
Lookup) — Select the appropriate check boxes for acceptable forms of data entry. 

 Click Save. 

 

You must only complete the settings available in the Configuration screen. Do NOT 
attempt to configure any settings from other screens prior to running the Deltek Time & 
Expense with Employee Self-Service 9.0.1 Data Migration program. See the Deltek 
Time & Expense with Employee Self-Service Time Collection Getting Started Guide for 
information on the settings and options available from the Configuration screen. 

Step 2: Backing Up Time Collection 4.1 Database 

Purpose 
This step provides instructions for making a backup of your Time Collection 4.1 database. 
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Where 
This step must be performed from the Microsoft SQL Server database server that hosts your 
Time Collection 4.1 database, or a Windows client workstation that can connect to your Time 
Collection 4.1 database with the Microsoft SQL Server 2000 Enterprise Manager client software. 

To backup your Time Collection 4.1 database, complete the following steps: 

1. Click Start » Programs » Microsoft SQL Server » Enterprise Manager. 

2. When the SQL Server Enterprise Manager screen displays, expand the Microsoft SQL 
Servers node of the hierarchical tree in the left pane, expand the SQL Server Group 
node, expand your database server name node, expand the Databases folder, and 
right-click your Time Collection 4.1 database (DELTEKET). 

3. Click All Tasks » Backup Database. 

4. When the SQL Server Backup screen displays, click the General tab, and perform the 
following: 

 Name — Enter a name for this backup set. 

 Description — Enter a description for this backup set (optional). 

 Backup — Select Database – complete. 

 Destination — Select Backup to Tape or Disk and then specify a backup 
destination. If no backup destinations display, click Add to add an existing destination 
or to create a new one. 

 Overwrite — Select Append to media (to append the backup to any existing 
backups on the backup device) or Overwrite existing media (to overwrite any 
existing backups on the backup device). 

 Click OK to begin the backup procedure. 

5. When you receive the “The backup operation has been completed successfully.” 
message, click OK. 

6. Close the SQL Server Enterprise Manager screen. 

 

For additional information on backing up your Microsoft SQL Server database, consult the 
Microsoft SQL Server documentation. 

Step 3: Backing Up Deltek Time & Expense with Employee Self-
Service 9.0.1 Database 

Purpose 
This step provides instructions for making a backup of your Deltek Time & Expense with 
Employee Self-Service 9.0.1 database. 

Where 
This step must be performed from the Microsoft SQL Server database server that hosts your 
Deltek Time & Expense with Employee Self-Service 9.0.1 database, or a Windows client 
workstation that can connect to your Deltek Time & Expense with Employee Self-Service 9.0.1 
database with the Microsoft SQL Server 2000 Enterprise Manager client software. 
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To back up your Deltek Time & Expense with Employee Self-Service 9.0.1 database, 
complete the following steps: 

1. Click Start » Programs » Microsoft SQL Server » Enterprise Manager. 

2. When the SQL Server Enterprise Manager screen displays, expand the Microsoft SQL 
Servers node of the hierarchical tree in the left pane, expand the SQL Server Group 
node, expand your database server name node, expand the Databases folder, and 
right-click your Deltek Time & Expense with Employee Self-Service 9.0.1 database 
(DELTEKTE). 

3. Click All Tasks » Backup Database. 

4. When the SQL Server Backup screen displays, click the General tab, and perform the 
following: 

 Name — Enter a name for this backup set. 

 Description — Enter a description for this backup set (optional). 

 Backup — Select Database – complete. 

 Destination — Select Backup to Tape or Disk and then specify a backup 
destination. If no backup destinations display, click the Add button to add an existing 
destination or to create a new one. 

 Overwrite — Select Append to media (to append the backup to any existing 
backups on the backup device) or Overwrite existing media (to overwrite any 
existing backups on the backup device). 

 Click OK to begin the backup procedure. 

5. When you receive the “The backup operation has been completed successfully.” 
message, click OK. 

6. Close the SQL Server Enterprise Manager screen. 

 

For additional information on backing up your Microsoft SQL Server database, consult the 
Microsoft SQL Server documentation. 

Step 4: Restoring Time Collection 4.1 Database to Deltek Time & 
Expense with Employee Self-Service 9.0.1 Database Server 

Purpose 
This step provides instructions for restoring your Time Collection 4.1 database to the Microsoft 
SQL Server 2000 database server that hosts your Deltek Time & Expense with Employee Self-
Service 9.0.1 database. 

Where 
This step must be performed from the Microsoft SQL Server database server that hosts your 
Deltek Time & Expense with Employee Self-Service 9.0.1 database, or a Windows client 
workstation that can connect to your Deltek Time & Expense with Employee Self-Service 9.0.1 
database with the Microsoft SQL Server 2000 Enterprise Manager client software. 
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To perform the data migration, your Time Collection 4.1 database must reside on the same 
Microsoft SQL Server 2000 database server that hosts your Deltek Time & Expense with 
Employee Self-Service 9.0.1 database. If your Time Collection 4.1 and 9.0.1 databases do not 
reside on the same server, you must restore the Time Collection 4.1 database backup you 
made, during Step 2 of this appendix, to the server that hosts your Deltek Time & Expense with 
Employee Self-Service 9.0.1 database. 

Skip this step if your Time Collection 4.1 and 9.0.1 databases already reside on the same 
server. 

To restore your Time Collection 4.1 database to the server that hosts your Deltek Time & 
Expense with Employee Self-Service 9.0.1 database, complete the following steps: 

1. Copy the Time Collection 4.1 database backup file that you made in Step 2 of this 
appendix to the Microsoft SQL Server database server that hosts your Deltek Time & 
Expense with Employee Self-Service 9.0.1 database. 

2. Click Start » Programs » Microsoft SQL Server » Enterprise Manager. 

3. Expand the Microsoft SQL Server node of the hierarchical tree in the left pane, expand 
the SQL Server Group node, expand your database server name node, expand the 
Databases folder, and highlight the master database. 

4. Click SQL Enterprise Manager » Tools » SQL Query Analyzer. 

5. When the SQL Query Analyzer screen displays, enter and execute the following 
statement in the Query input window: 

sp_addlogin DELTEKET, winet30, tempdb 

 

After executing this command, you should see the following output in the Query output 
window: 

New login created. 

If your output differs or you receive an error, contact Deltek Technical Support. 

6. Click File » Exit to close the SQL Query Analyzer screen and return to the SQL Server 
Enterprise Manager screen. 

7. Right-click the Databases folder, and click All Tasks » Restore Database. 

8. When the Restore database screen displays, click the General tab, and perform the 
following: 

 Restore as database — Enter the name of the Time Collection 4.1 database to 
restore (that is, DELTEKET). 

 Restore — Select From device. 

 Restore backup set — Select Database – complete. 

Click Select Devices. 

9. When the Choose Restore Devices screen displays, click Add. 

10. When the Choose Restore Destination screen displays, select File name. 

11. Enter or navigate to your SQL Server Time Collection 4.1 database backup file name. 

12. Click OK to close the Restore Destination screen. 

13. Click OK to close the Choose Restore Devices screen. 

14. On the Restore database screen, click the Options tab, and perform the following: 
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 Select the Force restore over existing database check box. 

 Specify the correct directory paths for the database file names that display under the 
Move to physical file name column. 

 Click OK to begin the restore procedure. 

 

For additional information on restoring your Microsoft SQL Server database, consult the 
Microsoft SQL Server documentation. 

15. When you receive the “Restore of database ‘<DB_NAME>’ completed successfully.” 
message, click OK. 

16. Highlight the master database, and click SQL Enterprise Manager » Tools » SQL 
Query Analyzer. 

17. When the SQL Query Analyzer screen displays, execute the following statement in the 
Query input window: 

sp_defaultdb 'DELTEKET', '<DB_NAME>' 

Where: 

<DB_NAME> identifies the name of your Time Collection 4.1 database (that is, 
DELTEKET) 

 

After executing this command, you should see the following output in the Query output 
window: 

Default database changed. 

If your output differs or you receive an error, contact Deltek Technical Support. 

18. After the statement executes, position the cursor in the Query input window and click 
SQL Query Analyzer » Edit » Clear Window. 

19. When the Query input window clears, enter and execute the following statement in the 
Query input window: 

sp_change_users_login 'Auto_Fix', DELTEKET 

 

After executing this command, you should see output similar to the following in the 
Query output window: 
The number of orphaned users fixed by updating users was 1. 
The number of orphaned users fixed by adding new logins and then updating 
users was 1. 
Or 
The number of orphaned users fixed by updating users was 0. 
The number of orphaned users fixed by adding new logins and then updating 
users was 0. 

If your output differs or you receive an error, contact Deltek Technical Support. 

20. Click File » Exit to close the SQL Query Analyzer screen and return to the SQL Server 
Enterprise Manager screen. 

21. Confirm that your Time Collection 4.1 database restored correctly by logging in to it with 
SQL Query Analyzer using the DELTEKET user login. 
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Step 5: Downloading Deltek Time & Expense with Employee 
Self-Service 9.0.1 Data Migration Scripts 

Purpose 
This step provides instructions for downloading the latest Time Collection 4.1 to Deltek Time & 
Expense with Employee Self-Service 9.0.1 database migration scripts. 

Where 
This step must be performed on the Microsoft SQL Server database server that hosts your 
Time Collection 4.1 and 9.0.1 databases or a Windows client workstation that has osql 
connectivity to your databases. 

To download the latest Deltek Time & Expense with Employee Self-Service 9.0.1 data 
migration scripts, complete the following steps: 

1. Create a TE90Migration folder on the C:\ drive of your database server. 

2. Go to http://www.deltek.com. 

3. Click the Support Login link in the upper right corner of the screen. 

4. When the Deltek Support Login screen displays, perform the following: 

 Username — Enter your Support user name. 

 Password — Enter your Support user’s password. 

5. Click Log In. 

 

If you have forgotten your username or password, click Account Assistance. If you 
have forgotten your username, enter your email address and click Email My 
Username. If you have forgotten your password, enter your username and click Reset 
My Password. 

6. When the Deltek Support Home Screen displays, click the Knowledge Center tab, and 
perform the following: 

 Refine by Product — Select Time & Expense from the drop-down list. 

 Leave the All Subs drop-down as All Subs. 

 Refine by Category/Version — Select Service Pack / Hot Fix from the drop-down 
list. 

 Change the All Subs drop-down to 9.0.1. 

 Search Type — Leave as Phrases or select how you want to search from the drop-
down list. 

 Search by Keyword — Enter TE90DataMigration. 

7. Click Search. 

8. When the search results display, perform the following: 

 Click the TE90DataMigration link for the desired correction (under the Summary 
column). 

 When the TE90DataMigration record displays, scroll down to the Answers section, 
click the TE90DataMigration link, and save the file to the C:\TE90Migration folder 
on your database server. 
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Step 6: Installing Deltek Time & Expense with Employee Self-
Service 9.0.1 Data Migration Scripts 

Purpose 
This step provides instructions for installing the Time Collection 4.1 to Deltek Time & Expense 
with Employee Self-Service 9.0.1 database migration scripts. 

Where 
This step must be performed on the Microsoft SQL Server database server that hosts your Time 
Collection 4.1 and 9.0.1 databases or a Windows client workstation that has osql connectivity to 
your databases. 

To install the Deltek Time & Expense with Employee Self-Service 9.0.1 data migration 
scripts, complete the following steps: 

1. Click Start » Run, enter C:\TE90Migration\TE90DataMigration.exe, and click OK to 
launch the Deltek Time & Expense with Employee Self-Service 9.0.1 Data Migration 
installation program. 

2. When the Introduction screen displays, click Next. 

3. When the License Agreement screen displays, review the license agreement, select the I 
accept the terms of the License Agreement option, and click Next. 

 

It may take several minutes for the License Agreement screen to display. 

4. When the Select Database Platform screen displays, select Microsoft SQL Server, and 
click Next. 

5. When the Choose Install Folder screen displays, indicate where you would like to install 
the data migration scripts by accepting the default folder (C:\TE90Migration), or choose a 
different folder by clicking Choose. After you have chosen the folder, click Next. 

 

The path and folder name you choose CANNOT contain any spaces. 

6. When the Enter Microsoft SQL Server Database Information screen displays, enter the 
following, and then click Next: 

 Server Name — Enter the computer name of the Microsoft SQL Server 2000 server 
that hosts your Time Collection 4.1 and Deltek Time & Expense with Employee Self-
Service 9.0.1 databases (that is, dbsvr01). 

 Time Collection 4.1 Database Name — Enter the name of your Time Collection 4.1 
database. The default is DELTEKET. 

 Time & Expense 9.0.1 Database Name — Enter the name of your Deltek Time & 
Expense with Employee Self-Service 9.0.1 database. The default is DELTEKTE. 

 Time & Expense 9.0.1 Schema — Enter the name of the Deltek Time & Expense 
with Employee Self-Service 9.0.1 database schema that will store your company’s 
timesheet data. The default database schema is TC_0002. 
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Your Deltek Time & Expense with Employee Self-Service 9.0.1 timesheet data is 
stored in one or more database schemas. You licensed and assigned a Domain 
Name to the TC_0002 schema during the Deltek Time & Expense with Employee 
Self-Service 9.0.1 configuration. 
The Domain Name you specified during the creation process is simply an alias for 
the database schema. Typically, the domain name will be shorthand for your 
company, division, or department name. The domain name you choose cannot be 
greater than 30 characters and cannot contain spaces. 

If you have not created additional domains (that is, for the schemas TC_0003, 
TC_0004, TC_0005, and so on), you should accept the default of TC_0002. If you 
have created additional Deltek Time & Expense with Employee Self-Service 9.0.1 
domains (see “Appendix D – Creating Additional Domains”), you must determine 
which domains and corresponding database schemas should receive the Time 
Collection 4.1 data. You must repeat “Step 6: Installing Deltek Time & Expense 
with Employee Self-Service 9.0.1 Data Migration Scripts” through “Step 10: Review 
Migrated Data” of this Appendix for each of your Deltek Time & Expense with 
Employee Self-Service 9.0.1 Domains (and corresponding database schemas). 

 Time & Expense 9.0.1 Domain Name — Enter the name you assigned to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 company domain during 
the TE 9.0.1 Configuration in “Step 2: Creating Deltek Time & Expense with 
Employee Self-Service 9.0.1 Company Domain”, Item 7. 

 

The Deltek Time & Expense with Employee Self-Service 9.0.1 Domain Name 
must be uppercase. 

 sa Password —  Enter the password for the Microsoft SQL Server sa user. 

 Confirm sa Password — Re-enter the password. 

 

The program will compare the sa password entries to make sure you have correctly 
typed the password values. 

7. When the Select UDT Table Migration Options screen displays, use the following table to 
determine which User Defined Table (UDT) Options to choose. Select the check box next 
to each UDT option that you want, and then click Next. 

 

For information on User Defined Tables, refer to the Deltek Time & Expense with 
Employee Self-Service Time Collection Getting Started Guide. 

 

User Defined 
table Option Option Description 

UDT01 This option migrates your UDT01 Master table and your UDT01 
Types table. You must select this option if you plan to migrate any of 
the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT01 values) 

 Links involving UDT01 

 Leave Type (if your Time Collection 4.1 system was configured 
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User Defined 
table Option Option Description 

to track leave by UDT01) 

UDT02 This option migrates your UDT02 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT02 values) 

 Links involving UDT02 

 Leave Type (if your Time Collection 4.1 system was configured 
to track leave by UDT02) 

UDT03 This option migrates your UDT03 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT03 values) 

 Links involving UDT03 

UDT04 This option migrates your UDT04 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT04 values) 

UDT05 This option migrates your UDT05 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT05 values) 

UDT06 This option migrates your UDT06 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT06 values) 

UDT07 This option migrates your UDT07 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT07 values) 

 Links involving UDT07 
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User Defined 
table Option Option Description 

UDT08 This option migrates your UDT08 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT08 values) 

UDT09 This option migrates your UDT09 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT09 values) 

 Links involving UDT09 

UDT10 This option migrates your UDT10 Master table. You must select this 
option if you plan to migrate any of the following: 

 Timesheets 

 Employee History (if your Time Collection 4.1 Employee History 
table used default UDT10 values) 

 Links involving UDT10 

 Leave Type (if your Time Collection 4.1 system was configured 
to track leave by UDT10) 

8. When the Select Link Table Migration Options screen displays, use the following table to 
determine which Link Table Options to choose. Select the type of link—Direct, Wildcard, 
or None (the default for each is None)—for each Link Table you choose’ and then click 
Next. 

 

To select the link type for all table options you must use the scroll bar to access all of 
them.  

 

For information on Link Tables, see the Deltek Time & Expense with Employee Self-
Service Time Collection Getting Started Guide. 

 

Link table 
Option Option Description 

Link12 Within Deltek Time & Expense with Employee Self-Service 9.0.1, the 
linking of UDT01 to UDT02 can be done either as a Direct Link or a 
Wildcard Link. You must choose the option based on how you 
configured Deltek Time & Expense with Employee Self-Service 
9.0.1. 

Link17 Within Deltek Time & Expense with Employee Self-Service 9.0.1, the 
linking of UDT01 to UDT07 can be done either as a Direct Link or a 
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Link table 
Option Option Description 

Wildcard Link. You must choose the option based on how you 
configured Deltek Time & Expense with Employee Self-Service 
9.0.1. 

Link19 Within Deltek Time & Expense with Employee Self-Service 9.0.1, the 
linking of UDT01 to UDT09 can be done either as a Direct Link or a 
Wildcard Link. You must choose the option based on how you 
configured Deltek Time & Expense with Employee Self-Service 
9.0.1. 

Link27 Within Deltek Time & Expense with Employee Self-Service 9.0.1, the 
linking of UDT02 to UDT07 can be done either as a Direct Link or a 
Wildcard Link. You must choose the option based on how you 
configured Deltek Time & Expense with Employee Self-Service 
9.0.1. 

Link29 Within Deltek Time & Expense with Employee Self-Service 9.0.1, the 
linking of UDT02 to UDT09 can be done either as a Direct Link or a 
Wildcard Link. You must choose the option based on how you 
configured Deltek Time & Expense with Employee Self-Service 
9.0.1. 

Link93 Within Deltek Time & Expense with Employee Self-Service 9.0.1, the 
linking of UDT09 to UDT03 can be done either as a Direct Link or a 
Wildcard Link. You must choose the option based on how you 
configured Deltek Time & Expense with Employee Self-Service 
9.0.1. 

9. When the Select Additional Table Migration Options screen displays, use the following 
table to determine which Additional Table Options to choose. Select the check box next 
to each Additional Table Option that you want, and then click Next. 

 

For information on Additional Tables, see the Deltek Time & Expense with Employee 
Self-Service Time Collection Getting Started Guide. 

 

Additional table 
Option Option Description 

Utilization Codes This option migrates your Time Collection 4.1 Utilization 
table. This option must be selected if you plan to migrate your 
Time Collection 4.1 UDT01 table. 

Leave Types In Deltek Time & Expense with Employee Self-Service 9.0.1, 
Leave Type tracks all leave. For each Leave Type, you may 
associate the particular UDT01, UDT02, or UDT10 that 
identifies the leave. 

In Time Collection 4, leave is tracked by UDT01, UDT02, or 
UDT10. This difference makes it questionable whether you 
want to migrate your leave types or not. Currently if you’re a 
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Additional table 
Option Option Description 

GCS Premier client or Costpoint 3.x client, you will want to 
migrate your leave types. However, if you are a Costpoint 5.0 
client, it would not make sense to migrate your leave types. 
This is because the Costpoint 5.0 interface has been updated 
to support leave types. 

Employee Classes This option migrates your Time Collection 4.1 Employee 
Class table. You must select this option if you plan to migrate 
any of the following: 

 Timesheets 

 Employee History 

Timesheet Schedules This option migrates your Time Collection 4.1 Timesheet 
Schedule tables. You must select this option if you plan to 
migrate any of the following: 

 Timesheets 

 Employee History 

Work Schedules This option migrates your Time Collection 4.1 Work Schedule 
Tables. You must select this option if you plan to migrate any of the 
following: 

 Timesheets 

 Employee History 

Employee Master This option migrates your Time Collection 4.1 Employee 
Master Table. You must select this option if you plan to 
migrate any of the following: 

 Timesheets 

 Employee History 

 Employee Leave 

 Employee Groups 

Employee History This option migrates your Time Collection 4.1 Employee 
History Table. This option must be selected if you plan to 
migrate the following: 

 Timesheets 

Employee Leave This option migrates your Time Collection 4.1 Employee 
Leave Table. This option cannot be migrated if Leave Types 
are not migrated. It you are creating new leave types, it is 
possible to download all Beginning Balances and Accruals 
from you accounting system, and, via a SQL script, populate 
the taken hours based on migrated timesheets. If you are 
interested in this option, please contact Deltek Technical 
Support for assistance.) 
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Additional table 
Option Option Description 

Employee Groups This option migrates your Time Collection 4.1 Employee 
Group Tables/Timesheet Tables. If you are a Costpoint 5.0 
client, Deltek recommends that you utilize the new employee 
group download feature included in the standard Deltek Time 
& Expense with Employee Self-Service 9.0.1 interface 
(instead of selecting this migration option). 

Timesheets This option migrates your Time Collection 4.1 timesheet 
tables. 

Charge Trees This option migrates your Time Collection 4.1 Charge Group 
tables. If you are a Costpoint 5.0 client, Deltek recommends 
that you utilize the new charge tree download feature 
included in the standard Deltek Time & Expense with 
Employee Self-Service 9.0.1 interface (instead of selecting 
this migration option). 

Wage Determination 
Schedules 

This option migrates your Time Collection 4.1 wage 
determination schedules. 

10. When the Password Utility screen displays, select one of the following: 

 Yes — Select this option to have the passwords for your Time Collection 4.1 users 
migrated to your Deltek Time & Expense with Employee Self-Service 9.0.1 database 

 

The uppercase value of your Time Collection 4.1 passwords will become your 
Deltek Time & Expense with Employee Self-Service 9.0.1 password. 

 No — Select this option if you do not want the passwords for your Time Collection 
4.1 users migrated to your Deltek Time & Expense with Employee Self-Service 9.0.1 
database. 

11. When the Pre-Installation Summary screen displays, review the installation parameters 
you have selected. If you want to change any settings, click Previous to go back and 
make the necessary changes. If you are satisfied with these settings, click Install to 
begin the installation. 

12. When the Install Complete screen displays, click Done to exit the installation. 

Step 7: Stopping Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for stopping the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. 

Where 
This step must be performed from a machine that has Web browser client access via TCP/IP to 
the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. 
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Microsoft’s Java Virtual Machine (MSJVM) or Sun Microsystems’ Java™ Virtual Machine (JVM™) 
must also be installed on this machine. 

 

The WebLogic Console tool used in this step requires either Microsoft’s Java Virtual Machine or 
Sun Microsystems’ Java Virtual Machine to be installed. If neither of these virtual machines is 
installed, you must install Sun Microsystems’ Java Virtual Machine. Sun Microsystems’ Java 
Virtual Machine is available free for download at http://java.com. 

To stop your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server, 
complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/console 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009 (that is, 
http://10.2.2.54:7009/console). 

2. When the WebLogic Server Administration Console screen displays, perform the 
following: 

 Username — Enter system. 

 Password — Enter the password for the WebLogic Administrative user. The default 
was weblogic. 

3. Click Login. 

4. When the WebLogic Server Administration Console Home screen displays in your 
browser, click the DeltekTE link that displays under the Domain Structure section in the 
middle of the left pane. 

 

It may take several minutes for the hierarchical tree to display in the left pane. If the 
hierarchical tree does not display or a new blank browser opens, you must add 
http://<IPAddress or ComputerName> (that is, http://10.2.2.154) to your Internet 
Browser Trusted Sites and/or install Sun Microsystems’ latest JVM™. See the previous 
note for more information. 

5. When the Settings for DeltekTE screen displays, select the Control tab, and perform the 
following: 

 DeltekTEServer (admin) — Select the check box that displays to the left. 

6. Click Shutdown, and select Force Shutdown Now. 

7. When the Domain Life Cycle Assistant screen displays, click either of the Yes buttons. 

8. Close the Web browser screen. 

http://java.com/
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It can take several minutes for your Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server to process the shutdown request. 

The shutdown request has completed if either of the following conditions on your 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server 
is true: 

 The Windows Command Prompt that was used to launch your Deltek Time & 
Expense with Employee Self-Service 9.0.1 WebLogic Server has terminated. 

 The status of the Deltek Time & Expense with Employee Self-Service 9.0.1 
Windows service that was used to start your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic Server has changed from Started to 
blank. 

Step 8: Migrating Time Collection 4.1 Data to Deltek Time & 
Expense with Employee Self-Service 9.0.1 

Purpose 
This step provides instructions for using the database scripts created in a previous step to 
migrate your Time Collection 4.1 data to your new Deltek Time & Expense with Employee Self-
Service 9.0.1 database. 

Where 
This step must be performed on the same computer where you installed the Deltek Time & 
Expense with Employee Self-Service 9.0.1 database migration scripts in Step 6 of this section. 

To migrate your Time Collection 4.1 data to your Deltek Time & Expense with Employee 
Self-Service 9.0.1 database, complete the following steps: 

1. Open a Windows Command Prompt, navigate to the directory where the Deltek Time & 
Expense with Employee Self-Service 9.0.1 Data Migration scripts were installed 
(C:\TE90Migration), and launch the following command script: 

TCtoTE 

 

The TCtoTE command launches a series of SQL scripts that will migrate your Time 
Collection 4.1 data to your Deltek Time & Expense with Employee Self-Service 9.0.1 
database. 

2. After the TCtoTE command script completes, open the TCtoTE.log file with a text editor 
(for example, Notepad) and search for any msg messages. If any msg messages are 
found, contact Deltek Technical Support. 

3. If you chose to migrate your Time Collection 4.1 user’s password to Deltek Time & 
Expense with Employee Self-Service 9.0.1, open the passwordMigration.log file with a 
text editor and review the password migration. 

4. Close the Windows Command Prompt. 
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The following files in your Deltek Time & Expense with Employee Self-Service 9.0.1 data 
migration installation directory (C:\TE90Migration) contain the database user passwords you 
provided earlier during the installation: 

 PasswordMigration.cmd 

 TCtoTE.cmd 

You should store these files in a secure location or remove them after you have successfully 
completed the installation. 

Step 9: Restarting Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server 

Purpose 
This step provides instructions for restarting the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. 

Where 
This step must be performed on your Deltek Time & Expense with Employee Self-Service 9.0.1 
WebLogic application server. 

To restart the Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server, 
complete the following steps: 

1. Click Start » Programs » Deltek Time & Expense with ESS 9.0.1 » Start Time & 
Expense with ESS 9.0.1 Server. This will display a Windows Command Prompt and 
launch a command script that starts the Deltek Time & Expense with Employee Self-
Service 9.0.1 WebLogic Server. When the Windows Command Prompt window displays, 
you will see a series of messages scrolling down the screen. 

 

It will take several minutes for the Deltek Time & Expense with Employee Self-Service 
9.0.1 WebLogic Server to start. 

2. If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server starts 
successfully, the following message will display near the bottom of the command line 
shell window: 

“<The server started in RUNNING mode. >” 

 

If your Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic Server encounters 
errors during the startup process, the “<The server started in RUNNING mode.>” message will 
not display and the command line shell (DOS window) may terminate. 

If you do not receive the “<The server started in RUNNING mode.>” message or the command 
line shell (DOS window) terminates, you must do the following tasks: 

 Make a copy of the 
C:\Oracle\Middleware\DeltekTE90\servers\DeltekTEServer\logs\DeltekTEServer.log 
file. 

 Contact Deltek Time & Expense Technical Support. 
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Step 10: Reviewing Migrated Data 

Purpose 
This step provides instructions for logging into your Deltek Time & Expense with Employee Self-
Service 9.0.1 system to review the data that was migrated from your Time Collection 4.1 
database. 

Where 
This step may be performed from any Supported browser client that has TCP/IP access to your 
Deltek Time & Expense with Employee Self-Service 9.0.1 WebLogic application server. This 
computer must be using a browser client supported by the Deltek Time & Expense with Employee 
Self-Service 9.0.1 release (see the System Requirements section for a list of supported browser 
clients. 

To login to your Deltek Time & Expense with Employee Self-Service 9.0.1 company domain 
and review the migrated data, complete the following steps: 

1. Open your Web browser and enter the following, case-sensitive, URL: 

http://<IPAddress or ComputerName>:<Port>/DeltekTC/welcome.msv 

Where: 

 <IPAddress or ComputerName> identifies your Deltek Time & Expense with 
Employee Self-Service 9.0.1 WebLogic application server. 

 <Port> is the unique port number that your Deltek Time & Expense with Employee 
Self-Service 9.0.1 WebLogic application server uses to listen for connections. You 
specified this port value during the Deltek Time & Expense with Employee Self-
Service 9.0.1 software installation. The default is 7009 (that is, 
http://10.2.2.154:7009/DeltekTC/welcome.msv). 

2. When the Deltek Time & Expense with Employee Self-Service screen displays, perform 
the following: 

 Login ID — Enter a user ID that exists in your Time & Expense company domain. 

 

The login ID is case-sensitive. 

 Password — Enter the password for the user. 

 Domain — Enter <Your_Domain_Name>. 

Where: 

 <Your_Domain_Name> identifies the company domain you assigned to the 
TC_0002 database schema when you originally installed the Deltek Time & 
Expense with Employee Self-Service 9.0.1 software. 

 Language — Select your language from the drop-down box (i.e., English/United 
States). 

3. Click Login. 

4. When the Select Time Zone window displays, for the logged in user (for example, 
install), accept the default time zone (for example, Eastern Standard Time 
(America/New_York), or select a different time zone from the drop down list. 

http://10.2.2.54:7001/DeltekTC/welcome.msv
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5. Click OK. 

 

After you select a default time zone for the user you will no longer be prompted with 
this window. 

6. When the Welcome screen displays, you can begin reviewing your migrated data. 

 

You must have Adobe Acrobat Reader installed on any browser client that intends to display or 
print timesheets or any other reports from the Deltek Time & Expense with Employee Self-
Service 9.0.1 system. 

Please note that if you are planning on fax attaching items to expense reports/expense 
authorizations, the PDF created by Fax/copier must be version 1.4 or earlier. 
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